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Manufacturer's Statement

Limited Warranty, Disclaimer, Limitation of
Liability

Zeus warrants this product for a period of 18 months from the
date of initial purchase against defects in materials and work-
manship. This warranty will not be honored if there has been
any attempt to tamper with or remove the external seal, which
isintended to preclude tampering with this product's digital or
RF components.

Thiswarranty does not cover damage caused by misuse or
abuse of this product or by acts of God or accidents or other
causes beyond the control of Zeus. Also not covered by this
warranty are claims other than by the original purchaser. Y our
sole remedy and our sole liability to you shall be to repair or
replace this product at our discretion if it does not meet the
requirements of this warranty.

Zeus. and its distributors shall under no circumstances be lia-
ble for any damages arising from the use of or the inability to
use this product or from any loss of revenue or profit, business
interruption, or other loss which my arise from the use of this
product.

THE WARRANTIES ABOVE ARE EXCLUSIVE AND IN LIEU
OF ALL OTHER WARRANTIES, WHETHER EXPRESS OR
IMPLIED, INCLUDING THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESSFOR A PARTICULAR
PURPOSE.

FCC Warning
This equipment complies with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful
interference in aresidential installation. Operation of this
deviceis subject to the condition that it does not cause harmful
interference; this device must accept any interference
received, including interference that may cause undesired
operation. This equipment generates, uses and can radiate
radio frequency energy and, if not installed and used in accor-
dance with the instructions, may cause harmful interference to
radio communications. However, there is no guarantee that
interference will not occur in aparticular installation. If this
equipment does cause harmful interference to radio or televi-
sion reception, which can be determined by turning the equip-
ment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:
*  Reorient or relocate the receiving antenna
e Increase the separation between the equipment and the
receiver.
e Connect the equipment into an outlet on acircuit different
from that to which the receiver is connected.
e Consult the dealer or an experienced radio/TV technician
for help.
IMPORTANT: Changes or modifications not expressly
approved by the party responsible for compliance could void
the user's authority to operate the equipment.
When a Zeus Radio Frequency (RF) product isinstalled in an
OEM device, this device must reference the enclosed Zeus
Wireless Transmitter. The information which the OEM must
reflect on thelabel is: “TRANSMITTER MODULE FCC
ID: NAJLRTO006" and “ This device complieswith Part 15
of the FCC Rules. Operation issubject to thefollowing two
conditions: (1) Thisdevice may not cause har mful interfer-
ence, and (2) Thisdevice must accept any interference
received, including interference that may cause undesired

Tested To Comply
FCwith FCC Standards

Home or Office Use

operation”.
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Chapter 1: Overview

WHY WIRELESS?

Welcometo the Zeus family of wireless Transceivers.
These frequency hopping transceivers are supplied
either as Stand-alone Transceivers (Model
ZLRT2100) that plug into the RS232 port of an
existing product, or as Design-in Transceivers that
can be built into OEM products (Model ZLRT2000),
both of which can be used to create wireless data
networks in the license-free band at 2.4 GHz. Zeus
Transceivers can function in awide array of network
topologies. This manual provides the information
you need to install, configure, and test these
transceiver modelsin avariety of these networks.

Zeus Transceivers provide the first practical and
affordable alternative to wire for industrial and
commercial applications where data must be
transmitted reliably and securely in awide range of

indoor and outdoor environments. These applications

are solutions for OEMs and Systems Integratorsin
need of reliable, secure, long-range, and low-cost
aternatives to wire for commercia and industrial
applications. There are hundreds of factory, office,
industrial, transportation, medical, financial, and
retail applications for which Zeus solutions are
ideally suited.
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Why Wireless?

Overview

Wireless data connectivity offers many advantages over wire:

*  Wireless systems are easier to install

e Wireless system installation and maintenance costs are lower

* Wireless links are feasible in many locations where wire is not

» Wireless installations can be reconfigured or relocated easily

e Wireless products are mobile

Reliability, security, range, and cost have been the traditional obstaclesto

widespread adoption of wireless data networks. But today frequency

hopping technology provides reliability comparable to and security

greater than wire. Zeus Transceivers have been designed specifically for

long range and low cost. Moreover, the license-free band at 2.4GHz

allowswireless data connectivity solutionsto be implemented without site

licenses or carrier fees. These devel opments make wirel ess data networks

more practical and affordable than wire for many applications.

Zeus wireless data connectivity solutions are more reliable, more secure,

longer range, and lower cost than wire:

* More Reliable
Zeus Transceivers evaluated with industry standard test equipment
have exceeded a bit error rate (BER) standard 100 times more
rigorous than for 10 BaseT Ethernet and 1,000 times more reliably
than cellular devices.

* More Secure
Zeus Transceivers utilize frequency hopping technology devel oped by
the military and refined by intelligence agencies to avoid interception
and interference. It is more difficult to intercept communications
between Zeus wireless devices than to tap awire.

* Longer Range
Zeus Transceivers operate through walls and floors up to 1,500 feet in
most buildings, and line-of-sight to the horizon outdoors. For longer
distances, networks of Zeus Transceivers can relay data packets to
and from out-of-range devices to significantly extend the range of a
wireless data network.

* Lower Cost
Wireless devices are installed at prices that can be afraction of the
cost of wires. Zeus devices can be moved or reconfigured at no
additional cost.

—
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Zeus Technology

Overview

ZEUS TECHNOLOGY

Zeus uses Frequency Hopping Spread Spectrum (FHSS) technology to
ensure secure, reliable long-range data transmissions. Zeus utilizes this
proven technology to provide OEMs and Systems Integrators with a
superior wireless data connectivity solution for many industrial and
commercial applications.

Frequency Hopping

Frequency Hopping Spread Spectrum technol ogy was developed by the

Interference

2.483 U.S. military to prevent interference or interception of radio transmissions

/ on the battlefield. Frequency hopping devices concentrate their full power
M/\/\ into avery narrow signal and randomly hop from one frequency to

J another within that spectrum up to 200 times per second. If they encounter

iz-“ interference on a particular frequency, the devices retain the affected data,

Receiving  'andomly hop to another point on the spectrum, and continue
Transmitting Transceiver  transmission. There are always spaces without interference somewhere in
Transceiver the allotted radio spectrum. A frequency hopping device will find those
spaces and compl ete a transmission where other wireless technologies
fail.

Zeus Transceivers operate in the license-free Industrial, Scientific, and
Medical (ISM) band at 2.4GHz. No one owns or licenses these frequency
bands. Consequently, anyone may operate awireless network in alicense-
free band without licenses or carrier fees (unlike cellular technology),
subject only to restrictions on how much power can be used (1 watt or less
inthe U.S.) and the type of radio signals transmitted (spread spectrum).
The U.S. FCC and telecommuni cations regulators in many countries have
designated this band for low-power license-free use.

Speed and Bandwidth

There isacommon misconception regarding speed and data connectivity;
specificaly, that faster is better. In computer and tel ecommunications
networks, higher speeds are unquestionably superior. However, thisis not
the case with wireless data connectivity. There are many circumstances
where range, in-building penetration, and reliability are more important
than speed.

—
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Zeus Technology

Overview
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Paying for more speed than what is necessary to implement a data
connectivity application is not efficient. The broader radio frequency (RF)
bandwidth needed to transmit higher data rates dramatically reduces
range. In contrast, the lower data rates used by Zeus allow narrow
bandwidths to be used. Thisisideal for intermittent, repetitive data
transfer, where the premium is on accuracy and long-range transmission.
Zeus products have been designed specifically to meet the requirements
of such applications. A lower data rate enables Zeus Transceivers to
operate within anarrow RF band over significantly longer ranges than
other 2.4 GHz Frequency Hopping or Direct Sequence Spread Spectrum
(DSSS) products.

Sessions and Links

Zeus Transceivers use demand-based frequency hopping where RFisonly
transmitted when there is data available to transmit. The initiating
transceiver istermed the master and the receiving transceiver is called the
dave. Any device (host or remote transceiver) can be a master or adave
depending on who initiates the data transfer. Zeus Transceivers transmit
data using sessions and links. A session represents a compl ete data
transfer cycle between two devices. The session lasts aslong asiit takes to
transfer all of the databeing sent. A session can be comprised of anumber
of links which represent the actual transfer of data between two devices.
Radio interference can break alink but not end a session. It may take
severa links to complete asession. If alink is broken, it is the job of the
master to reinitiate the link in order to complete the session. This strategy
reduces the collision rate of packets and RF interference from adjacent
devices.

Data going in and out of the transceiver viathe serial port is (or can be) a
continuous stream of information; whereas, data transmitted over the air
isbroken into frames. Links consist of these frames. The frame represents
the physical data packet transmitted per hop between units.

The transceiver’s channel access (communications link) is based on the
Carrier Sense Multiple Access (CSMA) protocol. This protocol has the
advantage of requiring no special coordination between remotes and
works best with alarge or variable number of remotes transmitting
infrequent bursts of data. Channel latency isexponentially distributed,




Zeus Technology

Overview

meaning there is await cycle during interference. During interference,
datais hopped to another frequency. Although thereisasdlight delay
during each hop, datais not |ost.

Error Detection and Correction

Zeus Transceivers provide CRC error correction, forward error correction,
and transmission retry to ensure complete transmissions, even in the most
demanding circumstances.

Thetransceiver usesthe ITU cyclical redundancy code 16 (CRC-16) for
error detection. Two separate CRC-16 checks are used within each packet
frame:

e Header Section
e Data Section

Most wireless systems experience single bit errors as the most common
type of reception error. Forward Error Correction (FEC) can be used to
correct for a specific number of bit errors within x-number of bits
transmitted. Zeus uses a‘ Half Rate Coding’ algorithm which achieves a
correction rate of 1 bit-error in 4 bits transmitted.

The transceiver maintains data integrity over the air by means of an
internal automatic-repeat-request (ARQ) protocol, which will resend
erroneous datauntil it isreceived correctly. Thetransceiver takes user data
and breaks it into packets which are then transmitted at a much higher
channel datarate. If the received packet has errors and is not correctable
viathe forward-error-correction (FEC) algorithm, the packet is rejected
and resent until avalid packet is received. The transceiver maintains two
4kB buffers (transmit and receive) which helps to support continuous
uninterrupted transfers even in noisy situations. See “ Broadcast Network”
on page 24 for details on how Broadcast Network behavior differs.

Transmit Power Control

Wireless devicesin close proximity often experience desensing or over-
loading. Zeus Transceivers minimize this problem by providing
adjustments in the Power Level Feed-Back Control Loop based on the

—
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Security

Overview

SECURITY
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time-averaged Received Signal Strength Indicator (RSSI) values and the
Actual Power Level Setting as shared between both devices during a
communication session.

Data Transfer Sessions

All units arein one of six possible sequential modes or phases of
operation which cover the complete cycle of data transfer.

Idle

Unit listens and scans in each of the 75 channels in the hop table. No
activity.

Link Acquisition

Datais present locally, unit beginsto ping (search) each frequency in hop
table to find the remote unit.

Synchronization

Units on both ends of data transfer synchronize their hopping patterns.
Data Transfer

In-sync units each alternate transmitting and receiving data in 32msec
intervals (32msec Tx, 32msec Rx). Each 64 msec they hop to the next
frequency.
Exit Phase

Data transfer is complete based upon the setting for number of frames of
No Data specified in the transceiver’s configuration.

End Connection
Datatransfer is complete, units return to Idle mode.

Frequency hopping is inherently more secure than other RF technologies.
In addition, each Zeus Transceiver has a Vendor 1D set in thefirmware
shipped straight from the factory. Asyou configure each transceiver you
may provide additional network 1D numbers and assign varying hop
tables for independent networks. The combination of firmware, software
IDs, and frequency hopping technology ensures safe and secure data
transmissions. Zeus Transceivers also support your data encryption
software.




Transceiver Features

Overview

TRANSCEIVER FEATURES

Zeus Transceivers enable OEMs and Systems Integrators to integrate
license-free 2.4GHz frequency hopping technology into their own
products. Each transceiver includes a proprietary RF module with a
frequency hopping transmitter and receiver, aDigital Control Module for
RF Module and Application Interface management, and an interface (TTL
or RS232) designed to communicate with a variety of products. The Zeus
Transceivers employ awireless interface designed to function as a virtual
wire replacement. This offers some distinct advantages over wire. Zeus
Transceivers:

USING THIS MANUAL

Enable mobility that may not have been possible before. And using
either the RS232 or RS485 serial connection, the transceivers can

connect devices at long range—up to 1500 feet indoors, and line of
sight to the horizon.

Compensate for baud rate differences between devices, eliminating
the need for converters between older, slower devices and newer,
somewhat faster ones.

Provide a GPIO (General Purpose Input/Output) mode for enabling
communication of status and control information in addition to data.
This ensures timely notification of state changes such as an “out of
paper” indication, eliminating the need for time-consuming manual
checking for such conditions.

Provide both Software and Hardware Flow Control to enable pacing
of data transmission between devices.

Enable efficient timed or batched transmission of data through data
thresholding capabilities.

Provide power control modes for power conservation.

Provide asymmetrical data rates to accommodate large directional
data transfers.

Provide the configurabilitiy to support a variety of network topologies.

Can be upgraded in the field.

All Zeus software applications are Windows® based and adhere to
Windows software conventions.

—
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Assumptions

Overview
The conventions used for instructions in this manual are as follows:
Convention Definition
bold Bold is used to indicate something that should be typed exactly or an exact
duplication of a window name or button.
click Click with the button on the mouse and rel ease. L eft button alwaysimplied on
Windows.
Control-e Hold down the Control key and press the E key.
double-click Click two times quickly on the mouse button and release.
right-click Click with the right button on the mouse and release.
select This can mean to highlight (which is the action of changing a screen object’'s
attribute to have an inverted look on the screen) icons or list items by clicking
or by clicking a menu item and dragging the cursor over its options to choose
that option or sub-item.
Shift-click Hold down the Shift key and click.
ASSUMPTIONS

It is assumed that you are familiar with your Windows operating system.
It is also assumed that your Windows operating System is operating in
default mode (e.g., double-click to open). All instructions in this manual
assume default mode (as delivered) operation.

GETTING HELP

Each software program has on-line hel p accessible through the help menu
within the program. Additionally, you can visit the web at
@ www.zeuswireless.com. Here you can find white papers containing
specific technology information, frequently asked questions, and other
H’? support resources. For Technical Support call 410-312-9851.

—
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Chapter 2: Installation and Specifications

This chapter discusses the physical installation of the
transceiver and the installation of the software
needed to configure each transceiver. All Zeus
Transceivers need to be configured for a specific
network topology. This processinvolves
understanding how the equipment is physically
installed and how the software isinstalled.
Sequentially, all transceivers are configured on a
Host PC prior to being physically attached to their
designated device. Configuration of the transceivers
isdiscussed in “Configuring Your Transceiver” on

page 27.

HARDWARE INSTALLATION

Prior toinstalling your transceiver(s), please count all
of the delivered equipment. Use your packing slip or
purchase order for verification. Each transceiver
needs power and an antenna. It will be attached either
internally or externally to asingle device(e.g., PC,
laptop, or printer).

Installing Design-in Transceivers

The Design-in transceiver has been shipped
according to your specifications. Depending on your
board configuration and the device you are placing it
in, you may need additional hardware (such as
screws and a screw driver) to mount the board. Power

* issupplied from your existing equipment through the

12 pin TTL connection.

1
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Hardware Installation

Installation and Specifications

Theintrinsically safe transceiver (Model ZLRT2010) must be mounted in
aNEMA or similarly approved enclosure. The cabling between your
equipment and the transceiver must be 24 gauge or larger and contain a
locking connector. For example, you could use aMolex 7880-12 or
equivalent female housing.

Note: Depending on how your transceivers have been configured, you may need
touseaTTL to RS232 converter (ordered separately) to connect to your
computer’s RS232 serial port and use the Configuration Manager. This
would be done prior to installing the transceiver into your egquipment. See
“Configuring Your Transceiver” on page 27 for more information about
configuring transceivers.

Installing Stand-alone Transceivers

To Install Stand-alone Transceivers

1. Insert the power supply male connector into the corresponding female
connector slot on transceiver chassis.

Power RS232 Antenna

Fl'"

2. Insert Power supply plug into power (i.e., power outlet)
Verify LEDs 1 and 2 on front panel blink threetimes. LED 1 remainslit.
3. Attach the Antenna to the transceiver.

Note that the antenna connection isareverse thread SMA connection.
You must turn it counter-clockwise to attach.

4. Attach the male connector on the RS232 cable to the matching serial port
on the rear panel of the transceiver.

5. Connect the other end of this cable to the matching serial port on the
device.

Note: Prior to installation on the desired device, all transceivers must first be

connected to and configured with a PC. In the case of some network
installations, it must be the Host PC.

—
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Interface Requirements

INTERFACE REQUIREMENTS

Installation and Specifications

Design-in Stand-alone
Input Power Requirements
Voltage +5.0 Volts, +/- 5% Greater than 6.5 Volts and
Less than 9.0 Volts
(6.5-32 Voltsif Wide Input
model)
Ripple Lessthen 10mV(RMS) fromDCto  Lessthen 250mV(RMS) from
1IMHz DC to 1IMHz
Currentinldle ~200mA ~200mA
mode
I nstantaneous 550mA 550mA
Current in Tx mode
Time averaged ~360mA ~360mA
(over 100mSec.)
Current in TX/Rx
mode

Physical Interface Regquirements

PCB connector: 1x12 right angle
connector; 0.025 square pin @ 0.1
spacing

Matching connector: AMP Part
Number 2-87499-1 or equivalent

Electrical Interface Voltage Levels

Input levels

Output levels

Open Collector
Output

Low <1.5 Volts;
High > 3.5 Volts @ 20uA
Low < 0.4 Volts;
High > 3.7 Volts @ 6 mA
Low < 0.7 Volts @12mA

PCB connector: Standard
DB-9(Female)

Low -3.0to -30 Volts;
High +3.0 to +30

Low < -5.0 Volts;

High > +5.0 Volts @ 3mA
N/A

—
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Design-in Transceiver Pin Out

Pin  Name 1/0 Function
1 TxD — Transmit Data Output Data from transceiver to the attached
device
CTS—Clear to Send Output HW Flow Control (default: asserted/High)
DSR — Data Set Ready Output Always Asserted (High)
DCD - Data Carrier Output Session Status (True)
Detect
RI —Ring Indicate Output Status Change (default: de-asserted/L ow)
RxD — Receive Data Input Datainto transceiver from the attached
device

RTS — Request to Send Input HW Flow Control (internally pulled up)
DTR — Data Terminal Input Data/Command Mode
Ready

9 +5 Volts Input Input Voltage

10 Gnd -- Signal Ground

11 Reserved -- Future use

12 Link Status Output External Link Status (Active Low)

Stand-alone Transceiver Pin Out

Pin name 1/0 Function

1 DCD - Data Carrier Detect Output Session Status (True)

2 TXD — Transmit Data Output Datafrom transceiver to the attached

device
3 RxD — Receive Data Input Datainto transceiver from the
attached device

4 DTR — Data Terminal Ready Input Data/Command Mode

5 Gnd - Signa Ground

6 DSR — Data Set Ready Output Always Asserted (High)

7 RTS — Request to Send Input HW Flow Control (internally pulled

up)
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Installation and Specifications

Pin name 1/0 Function

8 CTS—Clear to Send Output HW Flow Control (default: asserted/
High)

9 RI —Ring Indicate Output Status Change (default: de-asserted/
Low)

SERIAL COMMUNICATIONS

o,

()

H
L=

In order to configure any transceiver, you must use a9 pin RS232 cable.
Thisis necessary because pin 4 is used to transmit the configuration data
into EEPROM and other pins are used during the configuration process as
well. Zeus provides a9 pin RS232 cable with all Stand-alone
Transceivers. A TTL to RS232 pin adapter is purchasable for Design-in
Transceivers.

You must use the 9 wire cable in the following cases:

*  When using the Configuration Manager to initialize/setup a
transceiver.

*  When the Host PC is using network utilities.
* When field upgrading the transceiver.

Once configuration is complete, you may opt to use a3 or 5 wire cable
during field communication with Stand-alone transceivers. These cables
are not provided by Zeus. They can be purchased from a number of
SOUrces.

To determine which cable you need in the field

1. Evaluate which connections you need

Wire Type What's Connected

3 Wire Connection  Data (TxD/RxD) and Ground. Does NOT support Hardware Flow
Control; will work with no Flow Control or Software Flow Control

—
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Installation and Specifications

—

Note:

Wire Type

What’s Connected

5 Wire Connection

9 Wire Connection

Data and Ground; with Hardware Flow Control (RTS/CTS)

(receive, transmit, ground, hardware flow control). Required for
Hardware Flow Control, will also work with no Flow Control or

Software Flow Control.
All 9 pins are connected.

Determine whether you need a straight through or null cable.

The interface between the transceiver and the attached device is a Data
Communications Equipment (DCE) or Data Terminal Equipment (DTE)

connection requiring either a straight through or Null cable. The Null

cable (or Null adapter) simply crosses the required pinsto alow similar

devices to communicate properly (e.g., DCE to DCE). In general:
* The Zeus Transceiver is always a DCE device.

 APCistypically a DTE device.

» Remote devices (customer equipment) can be DCE or DTE depending
on the device.

» DCE to DTE communications require a straight through cable.

» DCE to DCE communications require a null cable or adapter.

The following diagrams assume that the DCE transceiver is sending data

to the DCE or DTE device.

3 Wire Straight Through Cable

DTE
Device

3 Wire Null Cable

DCE
Device

DCE
Transceiver

Pin 2 TxD Data Pin2
g
Pin 3 RxD Data Pin3
-
Pin 5 Gnd Pin 5
Pin 2 TxD Data Pin2
Pin 3 X RxD Data Pin3
- |
Pin 5 Gnd Pin 5

DCE
Transceiver
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5 Wire Straight Through Cable (flow control in use)

Pin 2 TxD Data Pin2

-
Pin 3 RxD Data Pin3

DTE Pin 5 Gnd Pin 5 DCE
Device Transceiver

Pin7 RTS Pin 7
Pin 8 CTS Pin 8

N

5 Wire Null Cable

Pin 2 TxD Data Pin2
Pin 3 >< RxD Data Pin3

-t >

DCE Pin 5 Gnd Pin 5 DCE
Device Transceiver

Pin 7 RTS Pin7

-t >
Pin 8 >< CTS Pin 8

l-’I )
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Hardware Specifications

Installation and Specifications

HARDWARE SPECIFICATIONS

Design-in Stand-alone
Transceiver
Frequency 2.400 - 2.4835 GHz license-free ISM band in same
U.S. (variesin other countries where Zeus
Transceivers have been certified)
Radio Type Frequency Hopping Spread Spectrum same
Number of 417 independent, non-interfering frequencies same
Channels
Data Rate 600bpsto 9.6 kbpsfull duplex, upto 19.2kbps  same
asymmetrical
Transmit Power 10mW to 500mW nominal, self-adjusting same
Output (lower maximum power output where
required)
Indoor Range Up to 1,500 feet (457 m) in normal same
construction
Outdoor Range Up to 2 miles (3.2 km) with omni-directional same
antenna
Up to 12 miles (19.3 km) with optional
directional antenna (line of sight to the
horizon)
Up to 75 miles (120 km) theoretical range
(line of sight to the horizon from towers above
the curvature of the earth)
Protocol CSMA (Carrier Sense Multiple Access) same
Flow control Supports Hardware, Software or None same
Warranty 1 year parts and labor same
Error Detection & CRC 16 error detection; forward error same
Correction correction can correct errorsin 1 out of every 4
bits transmitted
Certification FCC Part 15 Certified, Industry Canada, same
Japan, Europe, Brazil
Other International certifications pending
Electrical
Electrical Interface  Serial TTL Voltage Levels RS-232C Voltage Levels
Physical Interface 1x12 right angle connector (header) Standard RS-232C DB-9 (female) connector

—
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Software Requirements

Input Power

Input Current Draw

Environmental
Temperature Range
Humidity

Physica
Dimensions

Weight

Installation and Specifications

Design-in
Voltage: +5.0 V, +/- 5%

Ripple: Lessthan 10mV (RMS) from DC to
IMHz

Idle:
Transmit:

200mA
550mA instantaneous current

Transmit/Receive (time averaged over
100msec):  360mA

-4°F to +140°F, -20°C to +60°C

0% to 95% (non-condensing)

0.75 inches height (19mm) x 2.35 inches
width (60mm) x 4.25 inches length (108mm)

2.3 ounces (65grams)

SOFTWARE REQUIREMENTS

*  Windows® 95/98 or above (depending on software used)
e Pentium processor >233 MHz or higher

* 1 available RS-232 serial port

e Minimum 32 MB DRAM

Stand-alone

Shipped with a 115VAC power adapter
providing:

Voltage: > 6.5V and< 9.0V

Ripple: Lessthan 250mV (RMS) from DC to
1IMHz

same

same
same

1.2 inches height (30mm) x 3.8 inches width
(97mm) x 5.2 inches length (132mm)

6 ounces (170 grams)

e Maximum 20 MB hard disk space for Configuration Manager Plus
necessary Network Software Utilities

e 1 parallel port (for hardware key used in certain networks only for

Developer Kits)

SOFTWARE INSTALLATION

Configuration Manager

This program is used to configure all transceivers.

—
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Installation and Specifications

ANTENNAS
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To ingtall the Configuration Manager

1.
2.
3.

Make sure all Windows applications are closed.

Insert the Installation CD-ROM or diskette 1 into the appropriate drive.
Open the contents of the drive in your usual manner.

You can use Windows Explorer or My Computer on the desktop, for
example.

Double-click Setup.exe.

Follow the on-screen instructions.

Network Software Utilities

Ta

To install Network Software Utilities

1.
2.

Intercept and Library Utilities

Thisinstallation processis required if you are configuring transceiversin
networks using ComPort or TCP/IP Intercept, ActiveX, or DOS Utilities.

Insert the Installation CD-ROM or diskette 1 into the appropriate drive.
Open the contents of the drive in your usual manner.

You can use Windows Explorer or My Computer on the desktop, for
example.

Double-click Setup.exe.

Follow the on-screen instructions

If installing ActiveX, make sure to install the sample files as these will
provide the examples you need to create your own applications.

Antennas must be connected to each transceiver for proper operation.
Without an antenna, two units will not communicate. The higher the gain
of the antenna, the longer the range of the transceiver signal.

Zeus Transceivers are designed to be used only with certain antenna
products. Zeus offers the omni-directional antennas listed below as
compliant with FCC Certification for the transceiver. Zeus uses a unique




Antennas

Installation and Specifications

mechanical connection (reverse thread SMA connector) for all external
mount antennas to ensure that only compliant antennas are used with the
transceiver. Zeus does not endorse the use of omni-directional antennas
other than those listed below.

Zeus Part
Number Description

ZANT100  1dBi Omni-Directional Antenna(2")
ZANT101  2dBi Omni-Directional Antenna (6”)
ZANT102  3dBi Omni-Directional Antenna(5”)
ZANT103  5dBi Omni-Directional Antenna (9”)

Other higher gain directional antennas may be purchased through an
approved Zeus supplier. Contact Zeus for additional information.

—
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Chapter 3: Point to Point and Network
Topologies

Zeus Transceivers support Point to Point Pairs and
several Network topologies. Each Zeus Transceiver can
be configured viaits Configuration Manager to work in
any of these topologies. The transceiver’'s
Configuration Manager controls how the transceiver
transmits and receives data as connected to the device.
The operation of the transceiver in the network

topology is determined by its Network Software Utility.

POINT TO POINT PAIR

Dd 16

NETWORKS

In aPoint to Point topology, Zeus Transceivers are used
to connect two devices (e.g., abar code reader and a
printer), or aPC with asingle remote device. The Point
to Point topology can be considered a virtual wire
replacement (e.g., data in on one side equals data out
on the other side). Thisis useful for machine to
machine communications. All of the transceiver
featureslisted in “Transceiver Features’ on page 7
apply in Point to Point topol ogies.

Wireless data connectivity applications require awide
range of networking options. The Zeus Network
topologies consist of more than two transceivers and
may have a PC to host a network of devices. The host
and network devices are each physically attached to a
Zeus Transceiver.

1

In this Chapter

Point to Point
Pairs

Networks
Network Utilities
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The following Network topologies may require Network Software
Utilities. The required utilities are listed within each topology description
and explained in detail in “Network Software Utilities’ on page 25.
Depending on the topology and network utility combination you select,
some of the “Transceiver Features’ on page 7 may not apply. Thisis
explained for each topology.

Multi-Point Network

Note:

The Multi-Point Network enables data to be transmitted between as many
as 238 remote devices and a PC host. The transceiver connected to the
Host PC transmits and receives data from any other transceiver one at a
time. Sessions may beinitiated by any device on the network. Devicescan
be dumb (accept data directly without recognition) or intelligent
(recognize data transmission on a network and grab what applies). In a
Multi-Point Network there is no direct remote to remote communication,
everything must go through the host.

As opposed to a Point to Point topology, where you have a machine to
machine interface, Multi-Point networks are communicating at the
application level. Depending on the utility chosen, these networks can
communicate with one or more applications at atime. Multi-Point
Networks can be created with the following Network Software Utilities.

e ComPort Intercept
e TCP/IP Intercept
e ActiveX Library

* DOS Library

Depending on the network utility used, GPIO may be available. If you
assign GPIO mode to any remote on the network, the host must also be
assigned GPIO mode. The Host has a GPI O register so it can detect which
remotes are using GPIO.

Repeater Network

Zeus Transceivers in a Repeater Network function similarly to a Multi-
Point Network. They expand the range of the Multi-Point Network by
relaying data packets between otherwise out-of-range remote devices and
aHost PC. The effective transmission rate for data packets for devices
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Point to Point and Network Topologies

beyond direct connection with the host is reduced by one third. Data can
be transmitted between as many as 238 remote devices and a Host PC.
Thetransceiver connected to the Host PC transmits and receives datafrom
any transceiver one at atime. Sessions may be initiated by any device on
the network. Devices can be dumb (accept data directly without
recognition) or intelligent (recognize data transmission on a network and
grab what applies).

The most significant advantage of a Repeater Network is the ability to
extend range. Thisis advantageous when you have some remote devices
that are not within direct range of the host. This network extendsrangein
layers. These layers may overlap but you cannot go beyond 4 layers of
range. Datatravels through a single path to the receiving transceiver. This
network works well in environments where you do not need to
communicate large amounts of data but need to communicate over long
range. In the diagram below there are four layers. Datais sent from the
host through a path consisting of D, G, J, and M. Thisisthe single path
used to get the data from the host to M as M is out-of-range of the host.

10 10 10 10

Blod© 460 40 20

Note:

d (o) .34 (¢) g (3) .8 (w

Repeater Networks can be created with the following Network Software
Utilities:

e ComPort Intercept

e TCP/IP Intercept

e ActiveX Library

* DOS Library

GPIO, power management modes, and asymmetrical data flow rates are
not applicabl e to Repeater Networks. Even though you can use GPIO with
ComPort Intercept, you cannot implement this function on a Repeater
Network.

—
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Broadcast Network

_~a(®)
@_..LQ

Remote to Host (4 wire)

@—-Lé (©
i

Remote to All (2 wire)
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In aBroadcast Network, datais sent out by one transceiver (sending
transceiver) and received by an unlimited number of remote devices
simultaneously. These devices must be intelligent enough to recognize
relevant messages and recover lost or corrupted data. Broadcast Networks
operate solely as configured by the Configuration Manager.

The Zeus Broadcast Network has two modes of operation; Remote To All
and Remote To Host. In both modes all transmissions sent by the sending
transceiver can be received by every remote unit in its associated network.
The difference isin the way that transmissions by remote units are
handled:

e In Remote To Host, transmissions by remote units can only be
received by the host.

* In Remote To All, transmissions by remote units can be received by
every other unit in the network that is within range.

Unlike other Zeus Network topologies, in Broadcast there is no session
established between the units engaged in communication. This meansthat
transmitted datais not acknowledged by the receiving side. If, for
example, there isamomentary signal blockage at the receiving unit
location, the affected receiving unit will miss any data transmitted during
the signal blockage. Although signal impairments could cause data “ drop-
outs’ any data received over the wirelesslink is still checked and
corrected (if possible) by the Zeus error detection/correction process. This
ensures that datais error free.

Broadcast mode is especially useful to applications where you must
transfer the same information to all units at once or where a polling
protocol is employed to collect data from remote units. In polling
applications, the sending transceiver sends a query message to each
remote unit in turn, asking for any data that the remote unit has available.
The remote unit then has a chance to send its data to the polling
transceiver. In atypical polling arrangement, each remote must wait until
it is queried by the sending transceiver before transmitting. In this way
collisions between transmissions of more than one remote unit are
avoided. If, when polling a number of remotes, areply is not received




Network Software Utilities

Note:

Note:

Point to Point and Network Topologies

within a predetermined time interval the sending transceiver can
retransmit its query or simply move on to the next query on itslist.

Broadcast mode isintended primarily to be a RS485 network wire
replacement. It is especially useful in adding new equipment to older
(legacy) systems wherethereisa2 wire or 4 wire RS485 connection. The
4 wire connection is replaced with the Remote to Host mode and the 2
Wire connection is replaced with Remote to all mode. The Zeus RS232 to
R$485 converter is needed to configure Zeus Transceivers for RS485
devices.

The Broadcast Network does not support GPIO, data thresholding, or
power management and asymmetrical datarates are lower. Flow control
was not intended for use in this topology.

The sending transceiver’slink light will only turn on if aremoteis
sending data. The remote transceiver’s link light will always be lit when
synchronized on the network. The sending transceiver is aways
transmitting; however, other Zeus Networks will work when collocated
with a Broadcast Network as long as their hop table assignment is
different.

NETWORK SOFTWARE UTILITIES

Each network topology is supported by a combination of a Configuration
Manager which allows you to configure each individual transceiver for
your network topology and avariety of available Network Software
Utilities which allow you to arrange data transmission in your network.
Although summarized here, usage of each of these utilitiesis described in
detail throughout this manual.

ComPort Intercept is a software program which provides al the
functionality you need to assign virtual ports (enabling transparent
communication) in your Windows System Registry for a small network
configuration of up to 16 devices (including the host PC). See “ Setting up
a Network with ComPort” on page 49 for information on using this
software.

—
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Point to Point and Network Topologies

You can use this utility for the following network topologies:

e Multi-Point
* Repeater

TCP/IP Intercept

TCP/IP Intercept is a software program which provides al the
functionality you need to route wireless data through a Host PC to and
from as many as 238 devices on a TCP/IP based network. See “ Setting up

& m E (] . y . . . .
,L,’,g!j— _L s o :O I;ltst;l\;vrc;rk with TCP/IP” on page 61 for information on using this

@| ( ) You can use this utility for the following network topologies:

e Multi-Point
* Repeater

ActiveX Library

The ActiveX Library provides the standard ActiveX system callsyou
need to create applications which can link as many as 238 devices. See

“ActiveX Network Applications’ on page 73 for information on using this
software.

You can use this utility for the following network topologies:

e Multi-Point
* Repeater

DOS Library

The DOS Library provides the standard DOS system calls you need to
create applications which can link as many as 238 devices. Thisfeatureis
currently being tested and will not be documented further in this version
of the manual. You can use this utility for the following network
topologies:

e Multi-Point
* Repeater

—
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Chapter 4: Configuring Your Transceiver

The Configuration Manager is used to configure all
transceivers being used in al network topologies. The
procedures in this chapter describe how to configure
the transceiver to meet your specific needs. These
instructions assume that your transceiver isin default
OEM mode (as shipped) and correctly connected to a
PC with the Configuration Manager installed.

Note: To use Configuration Manager with aDesign-in
Transceiver, the TTL connection needs to be adapted to
an RS232 interface. TTL to RS232 converters can be
purchased upon request.

Note: All transceivers are delivered from the factory in
default mode with OEM privileges. If you have user
privileges, some features may not be available.

Note: You cannot open Configuration Manager if ComPort or
TCP/IP Activators are running.

To open your Configuration Management Application
1. From the Start menu in Windows, select Programs and
then Configuration Manager.

A splash screen appears with a Login dialog on top
reguesting username and password.

2. Enter the username: oem
3. Enter the password: oem

Note: oem islower case.

4. Click OK.
The Main Window appears.

1

In this Chapter

L]

Quick
Configuration

Modifying
Settings

Generating
Reports

Power
Management

Passwords and
Access

Using Hop
Tables

Assigning IDs

Signal Analysis
Serial Settings
Data Threshold
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Configuring Your Transceiver

Menu bar

e

B2 Configuration Program

Edi Commands Yiew Help

Tool bar L

“EEBEIY

Modification

(@ 7 B oco |2 o7k B3 RS ors| Eosk| T Connerdvid ¥ORTS IR He: (@ Comneied ——g

Status bar

tabs

T TeminalMode |

Serial Seltings |

General Advanced Settngs |

Special Featuies |

RX Pane

Loopback Test

Senial Number 0000005453
Date [10/25/93
Date [01/01/99

Wendor D |0
Alias Vendor Mame |ZEUS WIRELESS, INC.

Network D |2
Alias Network Name | Thomas

Sowrca UnitlD |1

Alias Source Mame [REMOTE 2
Destination Unit 1D |0

Fimware Rev. [1.14

Manufacturing Rev. [000

Quick Corfiguration

E :
Receive pane

TX Pane

Transmit pane

I

A Tip of The Day window also appears. A new tip of the day will appear
each time you open the configuration program. You can turn this off by
unchecking the box. Click OK to dismiss the window.

Getting Status

Status lights on the Status bar indicate the status of the control lines on the

RS232 link between the PC and the transceiver being configured.

| (B 7 /@ oco |3 ote| [ s cs| (@ osA)

—
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Abbreviation Name Definition
RI Ring Indicator A signd is coming into the host unit
from the transceiver at the remote
unit.
DCD Data Carrier A connection has been established
Detect with another unit. Thisletsthe PC
know that communication between
two units can take place.
DTR Data Terminal Indicates that the unitisin
Ready Command Mode. Thismodeis

utilized by the network software.




Configuring Your Transceiver

Abbreviation Name Definition

RTS Ready To Send Thisisahardware flow control
indicator

CTS Clear To Send A hardware control indicator

DSR Data Set Ready Reserved for future use

In addition to the status lightsin the Configuration Manager, the LED’son
the Stand-alone transceiver also display status.

Power Sync TX RX

The Toolbar
ick
Apply Store ggfﬁgure ClearRX  Help
FeloSERE Iy e
Refresh Reset Reload Change Clear Tx

Password

Exiting the program

To Exit the Configuration Manager

1. From the File menu, select Exit.

Note: Itisimportant to note that any changesin any tab not Stored in EEPROM
will be lost. See “Applying and Storing Changes” on page 34.

—
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Quick Configuration

Configuring Your Transceiver

QUICK CONFIGURATION

@ Thisisthe fastest and easiest way to configure a unit. Activation of Quick
Configuration loads settings directly into EEPROM. These settings will
remain in effect until a unit is reconfigured.

To use Quick Configure
1. Click Quick Configuration on the General tab, click it on the toolbar, or
select it from the Commands menu.

The Quick Configuration wizard appears with the Operating Mode
window displayed.

Select Operating Mode E

9 i
" H-to-M [ Host )
" H-to-M [ Femote )

" Repeater [Host |

" Repeater [ Remate |

" Broadcast [ Host )

" Broadcast [ Remate > Host )
" Broadcast [ Remate > Al )

()8 I Cancel |

2. Select the desired Operating Mode.

Select Point-to-Point to configure two units for a direct one-to-one
communication link.

Select H-to-M (Host) for a network configuration of 3 or more
transceivers. If host is configured first, the wizard will provide options for
configuring remotes. This feature is used for Multi-Point Networks. The
H-to-M (Remote) will follow after the host is configured.

Select Repeater (Host) for a network configuration of 3 or more
transceivers on a Repeater Network. If host is configured first, the wizard
will provide optionsfor configuring remotes. The Repeater (Remote) will
follow after the host is configured.

Select Broadcast (Host) for a network configuration of 3 or more
transceivers on a Broadcast network. The Broadcast (Remote to Host)
allows the remote to talk directly (only) to the host. You can also
configure aremote to talk to all remotes on the network. If host is
configured first, the wizard will provide options for configuring remotes.
See “Broadcast Network” on page 24 for amore detailed explanation of
Broadcast modes.

—
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Quick Configuration

Note:

Note:

Configuring Your Transceiver
To operate transceiversin Multi-Point or Repeater modes you will need to
install a Network Software Utility.

Click OK.
The Unit Settings screen appears.

“Point To Point" Unit Settings

Metwork. 10
Alias Metwark Mame ldan's—
Source Unit D |3
Alias Source Mame |scanner
Destination |0 IS—
Hop Table |4u v[ 1% &) %
— Serial Setting:
Fiate Parity... ,W
Flows Contral ,T Change |
GFI0 Mode Disabled

Subrmit I Cancel |

Enter the desired criteria.

Enter the desired identification numbers. See “Assigning IDS’ on page 43
for acceptable parameters. Select a Hop Table (0-100). The Hop Table
selected must be the same for al transceiversin a Point To Point Pair or a
Network. This number specifies atable of predefined frequencies, which
the transceiver will use for transmitting and receiving. If multiple separate
networks exist in the same area, each network should have a unique Hop
Table number to avoid RF collisions.

Depending on which network you selected in the previous screen, certain
ID fields may be grayed and inaccessible.

Click Change in the Serial settings group

—
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Configuring Your Transceiver

Note:
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The Serial Settings dialog appears. This allows you to set the various
serial port parameters.

Senal settings [ ]

BaudRate [3500 =]  [f

Cancel |

FlowContral [0 7]

[Drata Bits m

Farity lm
SwopBits [T | [ GRID

Supported parity, data and stop bits combinations:

7. Mone, 2 8. None, 1

7.0dd.1

7.0dd, 2 8, 0dd. 1
7.Even, 1 7. Even, 2 8. Even. 1
7. Mark, 1 7. Mark, 2 8. Mark. 1
7.Space.1 7. Space 2 8, Space, 1

Enter the desired settings

These should match the requirements for the device that the transceiver
will be attached to once the configuration is complete, not those of the
computer you are using to configure the transceiver. See the equipment
manufactures specifications for details. To use GPIO mode see “GPIO
Mode” on page 47.

Depending on which network topology you selected, some parameters
may be grayed and inaccessible. Some network topologies have required
serial settings.

Click OK.

Click Submit.

A Configuration Sequence dialogue box appears while the unit is being
configured. This shows the sequence of configuration steps asthey are

being executed. Upon completion, a Configuration Status box appears
with acheckbox option for report generation. All fields should read “OK”




Quick Configuration

9.

10.
11.

Note:

12.

Configuring Your Transceiver

if the configuration was successful. If you do not wish an ASCI| report to
be generated automatically, click Report generation to deactivate the
selection.

Walues | Changed £
Operating Mode: QK
Metwork 1d: ok
Metwork Alias: ok
Unit 1d: oK
Uit &lias: ok
Destination |d: ok
Hop Table: QK
Baud R ate: ok
FlowCtl: ok
Parity: QK
Max no Data: ok
Max Bad Hops: QK
4 | >
V¥ Report generation on Guick Configuration

Click Close.

A few more status dialogs appear. All entries are stored in EEPROM
permanently.

Click OK to configure another unit or Cancel to discontinue.

Continue to configure as many transceivers as required.

Disconnect the transceiver attached to the computer. Connect a new one.

Wait until thistransceiver'sinformation is displayed. Follow the on-
screen instructions.

Transceivers can be reconfigured as needed.

Select File and then Exit to exit the Configuration Manager.

If Report Generation was checked, Quick Configuration will
automatically create and store aconfiguration data profile for each unit
configured in the location specified in the Report Settings. See
“Generating Reports’ on page 36.

—

L= Transceiver User’s Manual

33



Modifying Settings

Configuring Your Transceiver

MODIFYING SETTINGS

You can run the Quick Configuration wizard to modify settings or you can
change entries manually in thefieldsin the modification tabs provided.
When manually changing entries, you must click apply and/or store for
the changes to take effect. See “Applying and Storing Changes’ on page
34.

To manually change dataiin fields

=

Click the desired tab.

Click in and highlight the data to be changed.
Change the data.

Click Apply and/or Store.

e @ SIS BE Gy @

P own

Applying and Storing Changes

The following features can be selected from the Commands menu or you
can click the appropriate button on the toolbar. These features write the
information entered into temporary or permanent storage.

Host PC Transceiver
Apply
RAM
__Store o —FEPROM

Note: Settings must be Applied before they can be Stored.

—
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Note:

Configuring Your Transceiver
Apply

This applies (transfers) changes from the all tabs into the attached
transceiver’'s RAM (temporary memory). Thisis useful when changing
and testing settings you are not sure you really want.

When you exit the configuration program these changeswill not remainin
effect. You must click Store for them to become permanent.

Store Applied Settings

Storesall Applied changesinto the transceiver’'s EEPROM. These settings
will remain in effect upon exiting the program. Stored changes are
overwritten when new stored entries are made or when you load the
default factory settings. You must Apply settings prior to storing them.

Reset Unit

Performs a soft reset of the attached unit returning the settings stored in
EEPROM. Any configuration settings Applied but not Stored to
EEPROM will be lost.

Load Default Settings

Reloads Factory Default settings into unit. All changes made previously
will belost.

Refresh

This queries atransceiver about its current settings. These settings will be
displayed on the screen. It lets you go back to the last Stored settings
before Apply was selected. Settingswill not be refreshed if Store has been
selected.

—
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GENERATING REPORTS

Reports can be generated during the Quick Configure (if the box was

\
)

e IR ¢

ﬁ ?% checked) or can be generated at any time using menu commands. Two
PN types of reports can be generated. Information in each report can be

_ FO\

cleared separately. Both reports generate text (.txt) files. The default
location for reports is C:\Program Files\Configuration Program. The
RReport.txt file produces a formatted text file which can be viewed using
any text reader or word processing program. For example, Microsoft
Word ®. The DReport.txt produces a comma delimited ASCII report
which can be viewed with any spreadsheet program, for example
Microsoft Excel®. It can also be imported into a database program like
Microsoft Access®.

To Add to an existing Report

1. From the File menu, select Add To Report.

The configuration data profile for the attached transceiver is added to the
report in the location specified under the Report Settings command.

To change Report Settings

1. From the File menu select Report Settings.

A dialog appears showing the settings and location for storage of
configuration data profiles.

Reports Files Settings [ ]
— Readable Report Setting:
[+ Output Readable Report Clear Report |

Fiepart File Location :
e IE:\PHDGHAM FILESYCOMNFIGURATION PROGRAMARR eport.t=t _I

Location of
file — Comma Delimited ASCIl Repart Setting:

[+ Output Comma Delimited A5CI Repart Clear Report |

Fiepart File Location :
—— IE:\PHDGHAM FILESYCOMFIGURATION PROGRAMADRepart. =t _I

V¥ Report generation on Guick Configuration

Cancel |

2. Select the type of report desired or both.

—
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Configuring Your Transceiver

Both files generated are ASCI| files readable by any text reader. A
readable report is formatted in ASCII with spaces and tabs to make it
readable when opened in programs such as NotePad.

Commadelimited formatting is useful when you want to import the text
into spreadsheet or database programs.

You can clear the contents of areport by clicking Clear Report.

If you wish reports to be generated when you run Quick Configuration,
the Report generation box must be checked.

Click OK.

To View reportsin ASCII form

1.
2.

From the File Menu, select Report Settings.

Locate the path to the desired report.

You can close this window and the Configuration Manager if desired.
Using a text reader such as Notepad or a word processor, open the file.

M PR na - Katepad
Fle Edit Sewth Heb
-
Ll e Lo P T
ssssmmssrenenenees [RASrdl ssssssssssssmmeas
Hedal TLATOAAN [Ree T}
Lerial Heshep; LULL L LR
Firmsare Revisien: 1.1%
Flirmsire Bevicisn Date: TS P
Hamuid acbering Bew: 0. B
Hamuf ackwring Erw Dabe: LR A Fe S
Uemdar 1k: a
N1EaS Uesedar Hae: FEUE WIRELESE,
IHE.
Helwark 10: L]
Alna=m Hetwark Hase Thamax
Fewroe Bedt 1B a
AlEas Sowroe Haeee o ST
bEstinatisn Unit I0O: ] |

To import reports into Microsoft Excel (for example)

Ll N

o

From the File menu, select Report Settings.
Check Tab Delimited.

Open Microsoft Excel.

From the File menu, select Import.

The Text Import wizard appears.

Import the DReport.txt file.

Click Comma and Tab in the Delimiters box.

—
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7. Click Next and fill out the rest of the wizard as desired.

Each commain the delimited file will be transformed into a column in the
Excel spreadsheet.

POWER MANAGEMENT

There are three modes which can be used to manage the power in your
transceiver. Each serves a specific purpose and has an advantage in certain
circumstances. For example, if you have a PC acting as a host to a bar
code reader and printer, you can have al three transceiversin different
power modes. The Host will be normal asit is always sending and
receiving data. The transceiver attached to the printer can doze asit will
only be receiving data and will wake up when it is needed to deliver
incoming data to the printer. The transceiver attached to the bar code
reader will only be sending so it can sleep until awakened by the reader
when it needs to send data to the printer. It is possible to conserve power
usage in this manner without sacrificing efficiency of data transfer.

To change power modes

1. Click the Special Features tab.

— Power Management
 Nomal
& Sleep
 Doze

— Data Threshold
™ Enable

Time |1D In 100 mzec. steps
Size I‘I Butes
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2. Click the desired Power mode.

Mode Explanation
Normal Unit operates at full power. LED is aconstant light.
Sleep Unit will enter a Sleep mode with minimal power requirements.

The unit will not wake-up until data appearslocally on the unit’'s
serial port for transmission. During Sleep mode reception of data
from another unit is not possible. Thisis practical for battery
applications and other low power requirements. LED on unit will
slowly blink on and off when unit isin Sleep mode.

Doze Unit will cycle the receiver on and off (at a 50% duty cycle).
Data can be received from another unit or transmitted from the
local unit during the Doze mode. Response timein receiving
data from another unit may be slightly longer than under Normal
power. LED on unit will blink very rapidly when the unitisin
Doze mode.

3. Click Apply and/or Store.

PASSWORDS AND ACCESS

Levels Of Access

There are two levels of access: OEM and USER. Each level has access to
different sets of fieldsin the Configuration Manager. A User hasthe
lowest level of access and isonly able to change parameters in some of
the fields available to OEMs. OEM s have access to all functions.

All transceivers are shipped with OEM access. It is up to the administrator
to assign user privileges from that point on.

Passwords

You can change your password as frequently as you desire. A password
consists of any combination of numbers or letters up to 29 characters. If
you forget your password, contact Zeus for a new password file. All units
are shipped with oem as the password. It is recommended for security
reasons to change your password from the factory setting.

—
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Depending on accesslevel, you have User or OEM privileges. The dialogs
that appear and the options available vary by privilege.

Note: All units are delivered with OEM privileges.

User Functions

To change your password as a user

1. From the File menu, select Change Password.
Change password dialog appears.
2. Enter the desired criteria.

Enter your user name and new password. Retype the new password in
Confirm Password.

3. Click OK.
OEM Functions

All units are delivered with default OEM privileges. The system
administrator must set units to User access.

To access OEM privileges

1. From the File menu, select Change Password.

Change password dialog appears.
oo :
User privelege
s
Updat

& OEM pdate | Mew |
o it [ FEme |
¥ Administrator Change password |

2. Select the desired User name from the list.
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3. Change user permissions as desired.

Privilege Options

User privileges Assign privileges as OEM or User. They can also be assigned
Administrator privilege which providesthe ability to change user
privileges. If you are assigned as a User, you can not add other
users or change the passwords of other users. Click update for
these changes to take effect.

New Add anew user by typing in their name and password. You must
retype the password to confirm it.

Change password Change the password of an existing user by typing in their name
and password.Y ou must retype the password to confirm it.

Remove users Removes the currently selected user.

USING HOP TABLES

A HopTableisalisting of frequenciesin agiven spectrum that are used
for communication. Datais sent to each frequency inthetablein a
hopping pattern. Hop Tables provide improved security and the ability to
avoid localized noise sources. There are 100 possible HopTablesin your
transceiver (this number may vary for international transceiver models).
These are subdivided into five completely independent, non-overlapping
Hop Table sets, each with no more than three consecutive frequencies.
Each individual network can only utilize one HopTable.

Entering Hop Table Numbers

Hop Table numbers can only be entered or changed by using the Quick
Configuration wizard.

Validating the Hop Table

This command verifies the integrity of the Hop Table stored within the
transceiver. The Hop Table in the transceiver is compared to the Hop
Table with the same number in the Configuration Manager database. The
Advanced Settings tab provides the selected Hop Table number and
whether the Hop Table has passed validation and the first and last indices

—
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used for the Hop Table. Index values are set to meet the requirements of
the country in which the transceiver is deployed for a minimum number of
hop frequencies. These values can not be changed to avoid violating
country regulations. To validate the Hop Table, from the Commands
menu, select Validate Hop Table.

Specifying Hopping Parameters

—
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You can customize Hop Table parameters by setting some features
available from the Advanced Settings tab.

Max No Data

Max No Dataisthe number of hop cyclesthat must pass during which no
data was received and no datawas available for transmission before a
session can be declared down. It is used as the trigger to end a session.
After acertain number of Frames No Data between both units, the master
will terminate the current session/link.

Max Bad Hop

Max Bad Hop is the number of data frames with errors received before a
link is considered bad. Thisisthetrigger to stop the current link and wait
for arandom standoff period (~0.5 to 3 seconds). Thisis due to the
assumption that after 4 (system default but can be changed) consecutive
bad hops, the link has been lost — either due to interference or lost
synchronization. By waiting a small amount of time before attempting to
reestablish the link, the obstruction (i.e., noise source) may have moved
somewhere else.

Session Holdoff

Thiswill only be enabled for a host transceiver and is required to manage
the communication from multiple remotes. It prevents a host unit from
starting a new session until it completesits current session. It keeps other
devices from establishing a session with the host until the host has
completed its current session with a particular device.




Assigning IDs

ASSIGNING IDS

Configuring Your Transceiver

Permanent Link

Thisisonly used in aPoint to Point configuration to keep alink between
the two units active at all times.

Using a combination of firmware and software assigned |Ds, the security
of your datais ensured. Some |Ds can be modified and others cannot
depending on your privileges. IDs are all accessed either via Quick
Configuration or the General Tab.

(GG LR T SE00 (Fey C)

Serial Mumber IDDDDDDE453
Firmware Rew. 114 Date [10/25/99
Manufacturing Rev. [0.00  Date [01/01/39

Wendor (D [0
Aliaz Vendor Mame [ZEUS WIRELESS, INC.

Metwork 1D [

Alias Metwork Name | Thomas
Source Unit 1D |1
Alias Source Name |REMOTE 2

Destination Lnit (D ID

Quick Configuration |

ID Type Explanation

Vendor ID Assigned at the factory and burned into the firmware. This
number is not modifiable. This ensures that no other Zeus
customer can intercept data assigned to your ID. There are
64,000 uniqueVendor IDs.

Network 1D A number that identifies the network and makes it unique from
other networks in the area. All unitsin anetwork must have the
same Network ID. The Network ID allows you to have multiple
networks within the same transceiver space. There are up to
64,000 unique numbers. Units with different | Ds cannot
communicate with each other.

—
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ID Type Explanation

Alias Network A descriptive name for the network.

Name

Source Unit ID For Point to Point communication the source and destination IDs

must be the same number for both transceivers. For most
network communication, the source ID = 0 for the host and the
source | Ds for the remotes are unique numbers from 1- 238.

Alias Source Name A descriptive name for the unit.

Destination Unit The numeric ID of the unit that the transceiver being configured

ID will communicate with. For Point to Point communication, the
destination ID will match the source ID. For a Multi-Point
network, the host will have adestination ID = X. The remotes
will each have a destination ID = 0 (the host source ID number).

The way source and destination |Ds are assigned differs between Point to
Point and Network configurations. In Point to Point the source and
destination |1 Ds between the two units must match. Any unit with a
different ID will not be able to communicate.

Transceiver 1 Transceiver 2 Transceiver 3
i <> l
Source=15 Source=15 Source=20
Dest.=15 Dest.=15 Dest.=20

In a Multi-Point Network the Source for the Host PC is always zero and
destination corresponds to the transceiver it istrying to communicate with
in each session. It is a dynamic number. The remote units have the
matching destination of zero but source numbers are unique.




Signal Analysis

Transceiver 1

4

Source=1

Dest.=0

SIGNAL ANALYSIS

Configuring Your Transceiver

Host PC

Transceiver 2

/ \
Source=0

Dest.=X Source=2

Dest.=0

There are a number of features which can help you analyze the strength
and consistency of your datasignal. They are available via the Advanced

Settings tab.
Feature Explanation
Tx Power The transmit power of the unit relative to the possible power
levels.
Power Ctrl Upper The upper RSS! (Received Signal Strength Indicator) threshold
Value which when surpassed causes the unit to reduce its transmit

Power Ctrl Lower
Value

Temperature

Local time-
averaged RSSI

Local
instantaneous RSSI

D/A | AID
Loopback

power.

The lower RSSI threshold which when surpassed causes the unit
to increase its transmit power.

The operational temperature of the unit as reported by the
thermistor in fractional volts.

The RSSI averaged over the last 16 transmissions. Used in
analyzing the strength and quality of the transmit signal.

The value of RSSI for the last transmission. Used in analyzing
the strength and quality of the transmit signal.

Factory Diagnostic.

—
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SERIAL SETTINGS

[ comrseonsnt The Serial Settingstab allows you to select the serial port, baud rate, flow
control, data bit size, parity, and stop bits settings. Each side of the
communication link need not have the same serial settings. Seria Settings
oo can aso be entered via Quick Configuration. These settings are how the

T = IG_F"E M;”E transceiver communicates with the device attached to it.
e

Explanation

Part IEDM1 -
Baud Rate I -
Parity INane -
Stop Bits |1 -
Supported parity, data and stop bits combinations: &Ettl ng
7. None, 2 8. None, 1 Port
7. 0dd, 1 7.0dd, 2 8. 0dd, 1
7.Even. 1 7.Even, 2 8. Even, 1
7. Mark, 1 7. Mark, 2 8. Mark, 1
7.5pace,1 7.Space,2 8 5pace, 1 Baud Rate
Flow Control
Data Bits
Parity

—
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The particular serial port number to be used. The default setting
isCOM1.

Speed of the serial connection for the device to which the
transceiver will be connected. Available options: 300, 600, 1200,
2400, 4800, and 9600 full duplex and 14,400 and 19,200 for
asymmetrical datatransfer. The asymmetrical rates will
automatically default back to 9600 full duplex during periods of
peak bi-directional data exchange. The default setting is 9600.
For aHost transceiver the setting must be 9600. Supported
values are: 600, 1200, 2400, 4800, and 9600.

A method of temporarily suspending the flow of data between
two devices. Available options: None, Hardware (RTS/CTS) or
Software (Xon/Xoff). The default setting is None. Software flow
control is not available for aHost transceiver. Flow control isa
means of temporarily suspending the flow of data between two
devices. The most popular methods are called hardware and
software flow control. Hardware flow control usesthe RTS/CTS
lines. Software flow control uses special characters, often called
tokens (Xon/Xoff) to achieve the same result. Hardware flow
control istypically the more common of the two methods. When
using asymmetrical datarates, hardware control should be used
to ensure data buffers are not overfilled which can result in aloss
of data. Supported valuesfor Flow Control are: None, Hardware,
or Software.

Represents the number of bits within each piece of data.
Available options: 7 or 8. The default setting is 8. A host
transceiver must be set to 8.

Traditionally used asamethod of detecting data errors. Available
options: None, Odd, Even, Mark, or Space. The default setting is
None. A host transceiver must be set to N.
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Setting

Explanation

GPIO Mode

Stop Bits

When enabled this allows for a General Purpose Input and
Output pin to be assigned on the RS232 connector (e.g. RTS &
CTS). This provides additional benefit for contact closure
applications such as opening/closing, turning on/off, notifying
when specific events have occurred. When this function is
enabled, Hardware Flow Control will be automatically disabled.

NOTE: You must assign control linesin your network utility
software for GPIO mode to take affect.

Available options: 1 or 2. The default settingis 1. A Host
transceiver must be set to 1.

Supported combinations for Data Bits, Parity, and Stop Bits are:

7, None, 2 8, None, 1
7,0dd, 1 7, 0dd, 2 8,0dd, 1

7,Even, 1 7, Even, 2 8, Even, 1
7, Mark, 1 7, Mark, 2 8, Mark, 1

7, Space, 1 7, Space, 2 8, Space, 1

Note: When setting up aHost device within aNetwork setting, the configuration
program will automatically preset the serial parametersto: 9600, 8, N, 1.
These settings are required for the Network Software Utility to ensure the
best possible data transfer speeds.

DATA THRESHOLD

This feature alows a predetermined time to elapse or amount of data to
accumulate before a data transfer session isinitiated. It is accessed
through the Special Features tab.

— Power Management
€ Momal
& Sleep
 Doze
— Data Threshold
™ Enable
Time |1D In 100 mzec. steps
Size I‘I Butes
—
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To set data threshold

1. Click the Special Features tab.

2. Click Enabled.

3. Enter Time and Size criteria.

Setting

Explanation

Time

Size

—
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A number (from 1 to 65,535) will specify the number of
100msec increments that must elapse between the initial receipt
of data (locally) before adatatransfer with another transceiver is
initiated. Thiswill provide up to 109 minutes of time that data
can accumulate before atransfer. The time must be set to ensure
that no more than 4K (the size of the data transfer storage buffer)
of data collects before atransfer occurs. If the buffer were tofill
up before atransfer, all additional datawould be lost.

Up to 4096 bytes of data can be collected before adatatransfer is
initiated.
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ComPort

ComPort Intercept™ is a Windows communication
driver (software application) that intercepts all RS232
traffic and automatically reroutesiit to/from the host
transceiver. It allows up to 16 transceivers to be
configured in a network topology. One transceiver is
designated as the host and is connected to alocal
persona computer with up to 15 remote unitsin the
network. The remote units can be dumb or intelligent.
The Host PC must be running a Microsoft Windows 95
or 98 operating system. ComPort Intercept allows the
host transceiver to be configured to provide the
network management functions. It can have multiple
applications on the host communicating through the
virtual ports at the sametime. It can be used for Multi-
Point or Repeater Network topologies.

This chapter discusses the configuration of the small
network. It assumes that the ComPort Intercept
software has been correctly installed.

ComPort Intercept consists of two components which
are designed to hook into Windows serial
communication traffic and transparently reroute the
data through a Multi-Point or Repeater Network. The
Configurator component is used to configure the
Windows System Registry, by creating virtual
communications devices. The Activator component is
the actual loader/driver that will run in the background
of the operating system and capture any configured
seria datatraffic and reroute it to the assigned remote
transceiver and application program.

1

In this Chapter

e ComPort
Intercept

e ComPort
Configurator

e ComPort
Activator

e Virtual Ports
e Physical Ports
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Note:

Note:

The host transceiver needs to be assigned to a physical communication
port (typically COM1 or COM2). Virtual ports are created and assigned a
remote Unit ID which corresponds to a particular remote transceiver's
Source ID Number thereby creating alogical association between each
virtual COM port number and a remote transceiver within the network.

The ComPort Intercept program will work with various client programs
that communicate via COM ports (e.g., HyperTerminal) with serial rates
of greater than 115K baud. While "over the air" data rates are effectively
9600 full duplex, the ComPort Intercept process will buffer datato each
application according to its particular requirements. Internal buffer space
for each virtual port is 8K Bytes.

You can not activate ComPort Activator if any other application is
currently using the Physical COM port that has been configured for the
host transceiver on the network (e.g., Configuration Manager).

COMPORT CONFIGURATOR

—

f=m Transceiver User’s Manual

50

Microsoft Windows requires that all physical and virtual ports be
registered within the System Registry for proper operation. ComPort
Configurator is used to create and configure virtual ports and assign them
to the host.

You can make changes to ComPort Configurator options either by
clicking the appropriate icon or clicking the right mouse button and
selecting the desired topic. All instructions given are based on clicking an
icon.

To run ComPort Configurator

1.

In Windows, select Start then ComPort Intercept Program and then
ComPort Configurator.




ComPort Configurator

Setting up a Network with ComPort

The ComPort Intercept main window appears.

,a?i. ComPort Configurator M= E3 Toolbar
S s I@e
System configuration and mapping Wirtual ports
AliasMame | Port_| UnitD | Alias Mame | Port_| UnitID |

o Serial 01 COM1
L ¥ Serial 02 COM2

™ Advanced View Exit |

Physical Port Window Virtual Port Window

Assignment Arrows

Note: For Developer Kits only, the hardware key must be connected to the
paralel port of the computer for the ComPort Configurator to run.

The Physical Port window shows:

« all physical COM ports as contained within the Host PC (this will
include any modems or other assigned ports)

 the one serial port assigned to the host transceiver

» any assigned virtual ports (if this is the first time you are running the
ComPort Configurator program, no virtual ports will be shown)

The Virtual Port window lists all available virtual portsthat have not been
assigned to a particular physical port (e.g., atemporary storage/
maintenance area). If thisisthe first time that you have used the Port
Configurator program, this area should be blank.

—
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When the program is opened, only the AddVirtual Port icon and Help
icons on the Toolbar are active. Other icons are deactivated.

Advanced View

This check box allows you to change the fields displayed in the main
window. Advance view provides more detailed information and options
by adding new columns. Theseinclude Input, Output, and Tx Purge which
are all described in this chapter.

,a?i. ComPort Configurator [_ (O] %]
—_ o1
— ey Y @R
System configuration and mapping Wirtual ports
Aliaz Mame | Port | Tx Purge [Threshold/Time... | Unit 1D ] Input | Alias Namel Fort | T= Purge [Threshold/Time... | UnitIDl |nput | Clutpr

o Serial 01 COM1
L ¥ Serial 02 COM2

| | | 4] |
W Advanced View Exit |

|l

Entering and Changing Information

You can use the left and right assignment arrows to move items between
the Physical Port and Virtual Port windows or you can drag and drop
items. There are also items available on the right-click pop-up menu.

—
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Adding Virtual Ports

You will need to add avirtual port for each devicein your small network.
New port numbers are created in numerical order. Up to 15 virtual ports
can be created; however, the actual number will be limited by the number
of physical COM portsthat are assigned. If the Physical Port window
shows more than the host transceiver as a physica COM port, the
available virtual portswill be decreased from 15 accordingly.

The number of virtual ports can vary depending on network size (15
remotes maximum) and the number of physical portsin use (if 4 Physical
Ports are in use, the maximum number of virtual ports will be 12).

To Add Virtua Ports:

1.

Click Add Virtual Ports on the toolbar.

You can aso right-click and select Add Virtual Port from the menu. This
applies to many featuresin this application.

The Add Virtual Ports dialog appears.

Add Virtual Ports [ ]
Mumber of Parts to add oK I
[ = |
Ii =1 Cancel |

Enter the number of ports you wish to add.

This number should equal the amount of devices on your network (not
including the host machine)

Click OK.

A message appears asking you to restart the computer.
Click NO.

Select a virtual port.

Click Assign Unit ID Number.

The Assign Device ID dialog appears which allows you to enter a Remote
Unit 1D number for the selected virtual port. The Remote Unit ID Number
isequa to aremote transceiver’s Source ID number. You can select a
number between 1 and 238.

Enter the desired number.

Repeat steps 6-8 for each port added.

—
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Note:

Note:

10.

Using standard Windows methods, you may also change the name of each
port whileit is selected.

Select the virtual port(s) in the Virtual Port window.

You can shift-click the first and last port to select all virtual ports or
control-click to select avarying group of ports, or you may do each port
individually.

Select the appropriate physical COM port in the Physical Port window.
Thiswill be the COM port to which the host transceiver is connected.
The left assignment arrow is enabled.

You can now associate each virtual port with aphysical host port as
displayed in the Physical Port window.

,a?i. ComPort Configurator [_ (O] %]
—_ o1
— ey Y @R
System configuration and mapping Wirtual ports
Aliaz Mame | Fort | T Purge [Threshaold/Time... | UnitIDl |nput | Alias Namel Fort | T= Purge [Threshold/Time... | UnitIDl |nput | Clutpr
|—n_}yi Serial 01 COM1 A_{Virtual EID _____ [ [3192 bytes/1000 zec] 2 Mone | Mone
- Serial 02 COM2 iitual .| CO.. 1 [0 bytes/0 sec] 4 Nane | None
- # virtu... (COM3_ [ [0 bytes/D sec] 1 Mane b Fvimual | Co.. O [0bytes/0 sec] 3 Mane | Nane
o # vittu... |COMS 1 [500 bytes/0 sec] 3 Nane !
L Fvitu.. COM7 O [0 bytes/0 sec] 5 Mane b
=
=
o TR T | 2
W Advanced View Exit |
4

11.

—
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Click the Left Assignment arrow.

Thiswill transfer the virtual ports to the host transceiver and establish the
virtual communication link between the host transceiver and remote
devices.

If your PC has more than one physical port, make sure you assign the
virtual portsto the correct physical port number.

Attach to Host is available on the right-click pop-up menu in the Virtual
Port window. When invoked, the currently selected port is moved to the
Physical Port window under the last selected host. Detach from Host is




ComPort Configurator

Note:

Note:

12.
13.

Setting up a Network with ComPort

available on the right-click pop-up menu in the Physical Port window.
When invoked the currently selected port is moved to the Virtual Port
window. These can be used instead of the drag and drop or the assignment
arrow features.

If you have selected multiple ports, it is more efficient to use the drag and
drop method to assign them.

Virtual ports can not be associated with a physical port until the Remote
Unit ID number has been assigned.

Click Exit.
Restart Windows.

Each time avirtual port is Added or Deleted, a message asking if you
want to restart windows will be displayed. Windows must be restarted
when virtual ports are added or deleted (thisis a Microsoft Windows
regquirement).

Setting Control Line Parameters

2.

Available in Advanced View, this feature allows you to assign Input and
Output lines. Y ou must have GPIO mode turned on for the host and at
least one remote on the network. Thisis assigned in the Configuration
Manager as shown in“GPIO Mode” on page 47. Any remote device using
GPIO mode can not use hardware flow control. GPIO mode will only
work in Point to Point and some Network topologies.

In Advanced View, click the Set Control Line icon.

A dialog appears.
Input Clutput
& Mone & Mone
LTS  RTS
" DSR  DTR
" DCD

You can aso select Control Lines from the right-click menu.
Click the desired radio buttons.
Select the desired input and output lines.

—
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3. Click OK.

The assigned input and output lines are displayed in the Input and Output
columns in the main window.

Tx Purge

Available in Advanced View, this feature allows you to create a buffer
within the ComPort intercept program for outgoing data. If the host is
sending but the remote is not ready to receive, this can be a useful tool.
You can set the buffer size and the amount of seconds before time-out. By
default, Purge Control is enabled with amaximum threshold (8192 bytes)
and atimeout setting (1000 seconds).

1. Select the desired port.

2. Right-click.
3. Select the Set Purge Control from the pop-up menu.
Threshold ’ Timeout
ID ﬁ Bytes ID ﬁ Sec
ak. I Cancel |

4. Select the desired criteria.

You can select the buffer size (Threshold) between 1 and 8192 and
amount of seconds between 1 and 1000 before time-out. Clicking the
checkbox will turn this criteriaon. The check will also be displayed in the
main window view.

5. Click OK.
Thisinformation is added to the TX Purge column for that port.

6. Toggle the purge feature on and off by checking/unchecking the box for
that port.

Remove Unit ID Number

selected virtual port. Remember that the Remote Unit ID Number is equal

l This button will remove the Remote Unit ID number associated with a
to aremote transceiver’s Source | D number.
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To remove |D numbers

Highlight desired port.
Click Remove Unit ID.
The ID isremoved. If an ID isremoved and you are |etting the program

increment IDs, the ID removed will be skipped and not reassigned. You
will haveto reassign it manualy, if desired.

Remove Virtual Communications Port

L/

This button will remove the selected virtual port from the system registry.

To remove avirtua port

1.
2.

Select the desired port.

Click Remove Port.

The port is removed from the display and from the system registry.
Remove all desired ports.

Restart Windows.

The port will not actually be removed until Windows is restarted.

Renaming Virtual Ports

The system will automatically name each virtual port sequentially. Y ou
can rename the virtual portsto a more conventional notation.

To rename avirtual port

1.
2.

Select the virtual port.
Right-click and select Rename.
The name field is now editable.
Edit the name of the port.

You may use up to 20 characters for the name. A descriptive name such as
“Printer”, may help you remember what equipment each port represents.

—
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USING COMPORT ACTIVATOR

3

Note:

Note:

To compl ete the setup of the Small Network, the ComPort Activator
program must be activated. This program resides in the lower right hand
of the computer task bar as represented by itsicon. ComPort Activator
runs in the background, captures virtual port traffic, and reroutesit as
specified by ComPort Configurator.

The Configuration Manager will not work if the ComPort Activator
program is running in the background. Suspend or unload ComPort
Activator when using the Configuration Manager to make changes.

For Developer Kits only, the white hardware key must be connected to the
paralel port of the computer for the ComPort Activator to run.

ComPort Activator

To run ComPort Activator

|E3mAS soam
1.

E3msaT sozam

Double click the ComPort Activator icon in the right hand corner of your
desktop or click Load Driver in the Configurator Main window.

You may aso select Start> Programs> ComPort Intercept Program>
ComPort Activator.

The icon now appears active and ComPort Activator isrunning in the
background. All serial communication traffic is redirected between the
host transceiver and remote transceivers according to the network of
virtual ports created with the ComPort Configurator program.

Note: If youright click theicon, alist of severa optionswill be displayed (Load
& Unload ComPort Activator, Load with Windows[at start-up] and Exit).
You can also open your ComPort Configurator from this menu.

Note: Once ComPort Activator isrunning, restrict all application programsfrom
using the physical seria port which has been assigned to the host
transceiver.

To stop ComPort Activator
1. Double click the ComPort Activator icon.
2. A red symbol indicates that ComPort Activator is now inactive.
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To start ComPort Activator when you start windows

1. Right-click the ComPort Activator icon.

2. Select Load With Windows.
ComPort Activator will automatically start each time you restart
Windows.

—
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Chapter 6: Setting up a Network with TCP/IP

TCP/IP Intercept™ is a software package that provides In this Chapter
e all the functionality you need to route wireless data . TCP/P

management functions. This chapter discusses the

configuration of the TCP/IP network. It assumesthat ~ * TCP/IP ports
the TCP/IP software has been installed. TCP/IP enables

multiple applications in various locations on the

network to communicate. Remote units can send data

to the host transceiver one at atime while the host can

send to many applications on the PC all at once

depending on the network topology. TCP/IP Intercept

can be used with Multi-Point and Repeater Network

topologies.

packets through a Host PC to and from as many as 238 Intercept
= ol devices. The remote units canbedumb or intelligent. | +~p )5
“%’.) < ; ) The Host PC must be running a Microsoft Windows 95 Configurator
— . @ or 98 operating system. TCP/IP Intercept allows the R
: host transceiver to be configured to support the network .
' @;L_@ Activator

TCP/IP Intercept consists of two componentswhich are
designed to hook into TCP/IP communication traffic
and transparently reroute the data through a Multi-
Point or Repeater Network. The Configurator
component is used to assign TCP/IP post addresses to
multiple devices on a network. The Activator
component is the actual loader/driver that will runin
the background of the operating system and capture
any configured TCP/IP traffic and reroute it to the
assigned remote transceiver and application program.

The host transceiver needs to be assigned to one
physical communication port (typically COM1 or
COM2). TCP/IP ports are created and assigned a
remote Unit ID Number that correspondsto aparticular
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Note:

Note:

Note:

Note:
Note:

remote transceiver's Source |D Number thereby creating alogical
association between each TCP/IP port and a remote transceiver within the
network. The entire network consisting of a host and multiple remotes
must reside on one physical COM port.

The TCP/IP Intercept program will work with various client programs
that communicate via TCP/IP assignable ports (e.g., HyperTerminal or
Telnet) serial rates of greater than 115K baud. While ‘over the air’ data
rates are effectively 9600 full duplex, the TCP/IP Intercept process will
buffer data to each application according to its particular requirements.
Internal buffer space for each TCP/IP port is 8K Bytes.

You cannot load TCP/IP Intercept any other applications are currently
using the physical COM port you have configured for your network (e.g.,
Configuration Manager)

All functions will be disabled in the Configurator if the Activator is
currently loaded.

You cannot implement GPIO mode on TCP/IP networks.

The base | P address used by the TCP/IP Intercept Program is that of the
Host computer. See your local system administrator if you are unsure of
the number.

TCP/IP CONFIGURATOR

—
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This program is used to create and configure TCP/IP ports and assign
them to the host.

You can make changes to TCP/IP Configurator options either by clicking
the appropriate icon or clicking the right mouse button and selecting the
desired topic. All instructions given are based on clicking an icon.

To run TCP/IP Configurator

1.

In Windows, select Start then Programs then TCP/IP Intercept Program
and then TCP/IP Configurator.

If you aready have TCP/IP ports configured, you can also open this
program by right clicking the TCP/IP icon at the bottom right of your
desktop and selecting Show Configurator.




TCP/IP Configurator
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The TCP/IP Intercept main window appears with the Design tab open.

A TCPAIP Intercept [_ ol ]
Design | Cortral
Change | | Toolbar
View CHG S9N
System configuration and mapping TCP ports
Aliaz Mame | Fort | TCP F'ortl Eonnectionsl Unit 1D ] Alias Name | TCP F'ortl Eonnectionsl Unit 1D ]
- Serial COM1 COM1
L ¥ Serial COM2 COM2
=
=
| 1]
Exit _I Load Driver | Help |

. . TCP/IP Port Window
Physical Port Window

Assignment Arrows Load/Unload Activator

The Physical Port window shows:

« all physical COM ports as contained within the Host PC (this will
include any modems or other assigned ports)

» one serial port assigned to the host transceiver

The TCP/IP Port window lists al available TCP/IP ports that have not
been assigned to a particular physical port (e.g., atemporary storage/
maintenance area). If thisisthe first time that you have used the TCP/IP
Configurator program, this area should be blank.

When the program is opened, only the Add TCP/IP Port icon and Help
icons on the Toolbar are active. Other icons are deactivated.

—
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Advanced View

This check box allows you to change the fields displayed in the main
window. Advance view provides more detailed information and options
by adding new columns. These include Input and Output which are
described in this chapter.

A TCPAIP Intercept [_ ol ]
Desian | Contil |
——P» ¥ Advanced View :II% g @ & )S@ "2
System configuration and mapping TCP ports
| Fort | TCP F'ortl Eonnectionsl UnitIDl |nput | Dutputl Alias Name | TCP F'ortl Eonnectionsl UnitIDl |nput | Clutput
M1 COM1
M2 COM2
=
=
o D] J 2]
Exit I Load Driver | Help |

Entering and Changing Information

You can use the left and right assignment arrows to move items between
the Physical Port and TCP/IP Port windows or you can drag and drop
items.

Adding TCP/IP Ports

@ You will need to add a TCP/IP port for each devicein your small network.
New port numbers are created in numerical order.
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To Add TCP/IP Ports:

1.

Click Add TCP/IP Port on the toolbar.

You can also right-click and select Add TCP/IP Port from the menu. This
applies to many featuresin this application.

The Add TCP/IP Port dialog appears.

Mumber of portz ~ Start from Max connections

A |
Lnit

’7|7 Auto assign Start |4 _|;
oK I Cancel |

Enter the desired criteria.

Enter the number of ports you would like to add. The total number of
ports should equal the amount of remote transceivers on your network
(not including the host machine). The maximum number of ports allowed
with the TCP/IP Configurator is no more than 238.

Enter the starting port number (these will be incremented by 1). The TCP/
IP port numbers available are between 1024 and 10,000. Enter the
maximum number of connections you would like to allow for each port.
The maximum number of connections cannot be greater than 8. These
connections should be the number of concurrent applications that will be
logged into the TCP/IP Intercept.

The Auto Assign feature allows you to automatically increment the
Remote Unit ID number as you are creating multiple TCP/IP ports. The
start window will allow you to choose the Remote Unit ID number you
wish to start with. This feature will be of particular use when configuring
alarge network from the beginning. Remember the Remote Unit ID
number must match the Source ID number of the remote transceiver.

You can also use the two buttons in the toolbar to Assign Unit ID Number
of Remove Unit ID Number.

Using standard Windows methods, you may change the name of each port
whileit is selected.

Click OK.

Select the port(s) in the TCP/IP Port window.
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Note:

Note:

A TCP/IP Intercept

You can shift-click the first and last port to select all TCP/IP ports or
control-click to select a varying group of ports, or you may do each port

individually.

Select the appropriate physical COM port in the Physical Port window.
Thiswill be the COM port to which the host transceiver is connected.
The left assignment arrow is enabled.

You can now associate each TCP/IP port with a physical communications
port.

All devicesin the network must reside on one physical port.

=] e
Desian | Contil |
W Advanced View :ll gg g @ @ 9@ @ K2
System configuration and mapping TCP ports
Aliaz Mame | Fort | TCP F'ortl Eonnectionsl Unit I Alias Name | TCP F'ortl Eonnectionsl UnitIDl |nput | Clutput
B+ Serial COM1 COM1 AWTCP1. 1024 8 1 Mone  Mane

o 1 CP 1025
| LghToPiozs

L ¥ Serial COM2 COM2

1026

8

L]

Exit I Load Driver |

Help |

6.
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Click the Left Assignment arrow.

Thiswill transfer the TCP/IP portsto the host transceiver and establish the
TCP/IP communication link between the host transceiver and remote
devices.

If your Host PC has more than one physical port, make sure you assign
the TCP/IP portsto the correct physical port number.

Attach to Host is available on the right-click pop-up menu in the TCF/IP
Port window. When invoked, the currently selected port is moved to the
Physical Port window under the last selected host. Detach from Host is




TCP/IP Configurator

Il

Note:

Note:

7.

Setting up a Network with TCP/IP

available on the right-click pop-up menu in the Physical Port window.
When invoked, the currently selected port is moved to the TCP/IP Port
window. These can be used instead of the drag and drop or assignment
arrow features.

If you have selected multiple ports, it is more efficient to use the drag and
drop method to assign them.

TCP/IP ports can not be associated with a physical port until the Remote
Unit ID number has been assigned.

Click Exit.

Editing Ports

a s b e

You can change the assigned TCP/IP port number and the maximum
amount of connections at any time.

Select the desired port.

Right-click.

Select the Edit TCP Port from the pop-up menu.
Select the desired criteria.

Click OK.

Setting Control Line Parameters

1.

Available in Advanced View, this feature allows you to assign Input and
Output lines. Y ou must have GPIO mode turned on for the host and at
least one remote on the network. Thisis assigned in the Configuration
Manager as shownin “GPIO Mode” on page 47. You can not use this
feature in conjunction with Hardware Flow Control.

In Advanced View, click the Set Control Line icon.
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A dialog appears.
Input Clutput
& Mone & Mone
LTS  RTS
" DSR  DTR
" DCD

You can also select Control Lines from the right-click menu.
2. Click the desired radio buttons.

Select the desired input and output lines.
3. Click OK.

The assigned input and output lines are displayed in the Input and Output
columns in the main window.

Remove Unit ID Number

@ This button will remove the Remote Unit ID number associated with a
selected TCP/IP port. Remember that the Remote Unit ID Number is
equal to a Remote transceivers Source |D number.

To remove |D numbers

1. Highlight desired port.
2. Click Remove Unit ID.

The ID isremoved. If an ID is removed and you are letting the program
increment IDs, the ID removed will be skipped and not reassigned. You
will haveto reassign it manually, if desired.

Remove TCP/IP COM Port
@ This button will remove the selected TCP/IP port.

To remove a TCP/IP port
1. Highlight desired port(s).
2. Click Remove TCP Port.
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The port is removed.
Note: The port can only be removed while it resides in the TCP/IP port window.

Renaming TCP/IP Ports

The system will automatically name each TCP/IP port sequentialy.Y ou
can rename the TCP/IP ports to a more conventional notation.

To rename a TCP/IP port

1. Selectthe TCP/IP port.

2. Right-click and select Rename.
The name field is now editable.

3. Edit the name of the port.

You may use up to 20 characters for the name. A descriptive name such as
“Printer”, may help you remember what equipment each port represents.

MONITORING ACTIVITY

You can monitor communication port, TCP/IP port, and connection
activity on your network.

To Monitor activity

1. Open TCP/IP Configurator.
2. Click Load Driver (if the Activator is not already loaded).
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3. Click the Control Tab.

A TCPAIP Intercept [_ ol ]

Design  Contral |

2
.r,—l"i COM1 Parameter I Walue |
- néyi m Status In Service [Opened)
Rx Count | O
Tx Count O

Opened es

Baud R... 5600

Yer. Major | 1

VYer. Minor | 14

Flow Co... | Flow Control Hardware
Parity Mo

Byte Size &

Stop Bits | 1

Exit I Unload Driver Help

4. Double-click the Communication port.

Information about the port is displayed on the right side of the window.
The TCP/IP ports are displayed.

5. Double-click the desired TCP/IP port.
Information about the port is displayed on the right side of the window.
The connections (1P addresses) are displayed.

6. Double-click the desired connection.

Information about the connection is displayed on the right side of the
window.

USING TCP/IP ACTIVATOR

be activated. This program residesin the lower right hand of the computer
task bar as represented by itsicon. TCP/IP Activator runsin the
background, captures traffic from TCP/IP port as assigned by TCP/IP
Configurator.

y To complete the setup of the network, the TCP/IP Activator program must
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A TCPAIP Intercept [_ ol ]
Design  Contral |
2
Parameter | Walue |
Status In Service [Opened]
Rx Count
10.1.10.50 Tx Count 15
Mo Connection gemgle I[[:) i E
- ession Counl
ED Eonnec:!on Session Dpen At... | 14
0 LAnnes !on Sesion Aborts 1]
Mo Connection Tx Overflow i
Mo Connection Rx Overflow 1]
Mo Connection Connections Rej... | 0
Mo Connection Connections Acc... | 1
25
26

Exit I Unload Driverl Help |

A TCPAIP Intercept [_ ol ]
Design  Contral |
2
Parameter | Walue |
Status In Service [Opened]
1024 Rx Count
Tx Count 15

Mo Connection TCPFlow... 0

Mo Connection
Mo Connection
Mo Connection
Mo Connection
Mo Connection
= Mo Connection

Note: You cannot load the TCP/IP Activator if any other application is currently
using the physical COM port you have configured for the network.
Suspend or unload TCP/IP Activator when using the Configuration
Manager to make changes.

Note: For Developer Kitsonly, the green hardware key must be connected to the

paralel port of the computer for the TCP/IP Activator to run.
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TCP/IP Activator

To run TCP/IP Activator

fOTLOY

1.

JoTIDG

Note:

Note:

Double click the TCP/IP Activator icon in the right hand corner of your
desktop or click Load Driver in the Configurator Main window.

The icon now appears active and TCP/IP Activator isrunning in the
background. All serial communication traffic is redirected between the
Host transceiver and remotes according to the network of TCP/IP ports
created with the TCP/IP Configurator program.

If you right click theicon, alist of several optionswill be displayed (L oad
& Unload TCP/IP Activator, Load with Windows [at start-up] and Exit).
You can aso open your TCP/IP Configurator from this menu.

Once TCP/IP Activator isrunning, restrict all application programs from
using the physical serial port which has been assigned to the Host
transceiver.

To stop TCP/IP Activator

1.
2.

Double click the TCP/IP Activator icon.
A red symbol indicates that TCP/IP Activator is now inactive.

To start TCP/IP Activator when you start windows

1.
2.
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Right-click the TCP/IP Activator icon.
Select Load With Windows.
TCP/IP Activator will automatically start each time you restart Windows.




Chapter 7. ActiveX Network Applications

im_Iis
Custom .
Application

WCI_OPEN

[
{

=1 )

Note:

The ActiveX Library provides anumber of APl system  In this Chapter
calls which can be used to create custom network « Location of
applications which can link as many as 238 devicesin sample files
Multi-Point and Repeater Network topologies. One Acti

o . . * ActiveX API
application controls the entire network. The ActiveX
driver may be used for Windows NT aswell as
Windows 95/98 and above.

You can use any Windows compliant compiler,
however, the examples provided in the following
functions are specific to Visual C++, Visua Basic, and
Visual J++. The sample code placed on your system
during installation is also based on these three
compilers. These files have been modularized to
emphasize the unique properties of each of these
compilers and the various system calls. Please use
these examples as your instructional material for
creating an application template. They are located in
C:\Pogram Files\Zeuswireless\Samples. These samples
include asimple Host to Multi-point application, aping
application, a background printing function, and
complex example that incorporates all of these. This
chapter provides the entire ActiveX API.

GPIO transactions are performed on a per device basis.

Thisfunction is used to open a communications port
(handle) and establish a connection with the host
transceiver. The specific Serial Port number is assigned
within the properties screen of the ActiveX device, this
is adesign time variable assignment.
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wCi_Close

ActiveX Network Applications

Syntax
| Handl e = wCi _Open() as | ong;

Return Value
> 0 handle of the communication,

< 0 Failure to connect the port.

WCI_CLOSE

Thisfunction is used to close the communications port, which was
previously opened with the wCi_Open function.

Syntax
void wC _C ose(l ong | Handl e)

Parameters

IHandle The handle of the communication returned
from wCi_Open.

WCI_WRITEDATAEX
Thisfunction is used to write the data buffer to a specific destination ID.

Syntax

Result = wC _WiteDataEx( VARI ANT WiteBuf, |ong
WiteLen, long | DestlID, long | Handl e) as |ong;
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ActiveX Network Applications

Parameters
WriteBuf The data to be transmitted.
WriteLen Number of bytes contained in the string.
IDestID The identity of the destination unit that data will be
transmitted to.
IHandle The handle of the communications port being used.
Return Value
Result > 0 Thelength of transmitted data.
= 0 No data was transferred.

< 0 No transceiver is available to transfer.

WCI_GETDESTINATIONID

Thisfunction is used to get the current identity of the destination unit as
contained in the host unit.

Syntax
Result = wG _GetDestinationl D(long | Handl e) as | ong;

Parameters

IHandle The handle of the communications port being used.

Return Value

Result The ID of the destination unit.

WCI_CHECKRXQUE

Thisfunction is used to check the number of incoming messages
contained within the receive queue.
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ActiveX Network Applications

Syntax
Result = wC _CheckRxQue(l ong | Handl e) as | ong;
Parameters
IHandle The handle of the communications port being used.

Return Value

Result Returns the number of the incoming messages
currently in the receive queue.

WCI_SETOUTPUTDEVICEID

Thisfunction is used to set the output deviceto log all incoming data. All
data received from any remote device will be passed up to the application
program as well as forwarded to the listed devices.

Syntax
voi d wC _Set Qut put Devi cel D(short iPrintID, |ong
| Handl e) ;
Parameters
iPrintID The ID of the output device.
IHandle The handle of the communications port being used.

WCI_STARTSTOPPRINTING

Thisfunction is used to start and stop the logging of the output device.

Syntax

void wC _StartStopPrinting(short iStatus, |ong
| Handl e) ;
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wCi_GetSourcelD
ActiveX Network Applications

Parameters
i Status The status of output device. ‘True' starts logging.
‘False’ stopslogging.
IHandle The handle of the communications port being used.

WCI_GETSOURCEID

Thisfunction is used to get the host transceiver’s ID.
Syntax
Result = wC _Get Sour cel D(1 ong | Handl e) as | ong;

Parameters

IHandle The handle of the communications port being used.

Return Value

Result Returns the host transceiver’s ID.

WCI_SETGPIOOUTPUT

Thisfunction is used to set the GPIO output line on the specific device.

Note: GPIO must be enabled on the host transceiver as well as the listed device
contained in this function call. GPIO is enabled via the Configuration
Manager as described in “Quick Configuration” on page 30.

Syntax

wCi _Set Gpi oQut put (short i Status, long | DestlD, |ong
| Handl e) ;
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ActiveX Network Applications

Parameters
i Status Output status which canbe 0 or 1.
IDestID The destination ID.
1Handle The handle of the communications port being used.

WCI_GETGPIOOUTPUT

Thisfunction is used to read the current GPIO output status line on the
selected devices.

Note: GPIO must be enabled on the host transceiver as well as the listed device
contained in this function call. GPIO is enabled via the Configuration
Manager as described in “Quick Configuration” on page 30.

Syntax
Result = wC _Get Gpi oQut put (1 ong | Dest1 D, |ong | Handl e)
as short;
Parameters
IDestID The destination ID.
IHandle The handle of the communications port being used.

Return Value

Result Returns the status. 0is OFF, 1 is ON.

WCI_GETGPIOINPUT

Thisfunction is used to read the GPIO input status line on the selected
device.

Note: GPIO must be enabled on the host transceiver as well asthe listed device
contained in this function call. GPIO is enabled via the Configuration
Manager as described in “Quick Configuration” on page 30.
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ActiveX Network Applications

Syntax
Result = wC _Get Gpiolnput(long | Destl D, |ong | Handl e)
as short;
Parameters
IDestID The destination ID.
IHandle The handle of the communications port being used.

Return Value

Result Returns an integer which denotesthe status. 0 is OFF
1isON.

WCI_GETGPIOMODE
Thisfunction is used to verify that GPIO has been enabled.

Note: GPIO must be enabled on the Host transceiver aswell asthe listed device
contained in this function call. GPIO is enabled via the Configuration
Manager as described in “Quick Configuration” on page 30.

Syntax

Result = wC _Get Gpi obde(l ong | Dest1 D, |ong | Handl e)
as short;
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ActiveX Network Applications

Parameters
IDestID The destination ID.
IHandle The handle of the communications port being used.

Return Value

Result Returnsalif GPIO is enabled.

WCI_PING
Thisfunction is used to check if a particular remote device isavailable.
Syntax
Result = wCG _Ping(long | DestID, |ong | Handl e) as
short;
Parameters
IDestID The destination ID.
IHandle The handle of the communications port being used.
Return Value
Result Returns the following possible status results.
0 - Not available
1- Available
2 - The host deviceis currently too busy to perform
this check
ABOUTBOX
Thisfunction is used to display the About message box (i.e., version
number).
—
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NewMessage

ActiveX Network Applications

Syntax
voi d About Box();

NEWMESSAGE
Thisis an event/callback function that occurs whenever a new message
has been received from the driver.
Syntax
voi d NewMessage(short i Status, |ong | DestlD, VARI ANT
Dat al nfo, |ong Datal en);
Parameters

i Status Predefined message types:
0 — Data received
1 —Time-out or error condition
4 — GPIO event, remote input when low
5 — GPIO event, remote input when high

IDestID The destination ID.
Datalnfo The string that has been received.
Datalen Number of bytes contained in the Datal nfo string.

ACTIVEX DESIGN TIME PROPERTIES PAGE:

CommPort The specific Serial Port connected to the host
transceiver. Range: 1, 2, 3 and 4.
Timeout A global timeout value (in seconds) used when

attempting to communicate with a remote device.

—
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ActiveX Design Time Properties

ActiveX Network Applications
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Chapter 8: Testing Your Units

You can test the operation of transceiversin avariety of  In this Chapter
way's using the Configuration Manager. The .
instructions in these chapter assume that the

Terminal Mode

Configuration Manager is correctly installed and the * Loopback
transceiver is properly connected to your PC. These * Rxand Tx
testsinclude: e

e Using

e Terminal mode

HyperTerminal
e Loopback test (Stand-alone model only)

TERMINAL MODE TEST

The Terminal Mode tab provides a simple terminal
interface from which data can be sent between two
units configured as a Point to Point Pair. Anything
typed in the input field of transceiver 1 will
immediately be transferred to transceiver 2. The datais
displayed in the transmit pane for transceiver 1 and the
receive pane for transceiver 2. (Note you will only see
received dataif the destination transceiver is connected
to a PC with Configuration loaded and open or if the
destination PC’s transceiver has aloopback connector.)

What You Need

* Two transceivers (A and B) configured as a Point to
Point Pair
The Source Unit ID of unit A equalsthe
Destination Unit ID of unit B and vice-versa. In
addition, both units must have matching Vendor 1D
numbers, Network ID numbers and Hop Table
numbers.

1
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Terminal Mode Test

Testing Your Units

*  One of these units is connected to a PC with the Configuration
Manager loaded.

Performing the Test

To test communications between units:

1. Open the Configuration Manager.
See “Configuring Your Transceiver” on page 27.
2. Click the Terminal Mode tab.
3. In Test String, enter some text.
4. Click Resent.
Thetest string is transmitted to the Destination Unit

| B~ B oo /B o] [ Ars|B cs| [ 0sA] T comtiion B RTS A @

i | e |

Transceiver User’s Manual

® i



Loopback Test

LOOPBACK TEST

Testing Your Units

The Loopback Test screen alows you to perform two functions; to test
that two units can communicate and to determine the best placement of
one unit relative to another based on received signal strength. Thistest is
only used for stand-alone models.

What You Need

» Two transceivers (A and B) configured as a Point to Point Pair
The Source Unit ID of unit A equalsthe Destination Unit ID of unit B
and vice-versa. In addition, both units must have matching Vendor 1D
numbers, Network ID numbers and Hop Table numbers. Transceiver
A is connected to a PC |oaded with the Configuration Manager,

» Loopback connector

Transceiver B (the one not connected to the PC running this program)
must have a loopback connector (pins 2 and 3 of the serial port tied
together) on the serial port of the remote unit. A loopback connector
is delivered with all demo and devel oper kits.

Performing the Test

To test communications between units

1.

Open the Configuration Program.

See “Configuring Y our Transceiver” on page 27.

Click the Loopback Test tab.

In Test String, enter some text.

Enter the desired criteria in other fields in this group.

The default values are recommended for this type of testing. 100 msec is
minimum for Repeat Every.

Click Start.

Thetest string is transmitted to the Destination Unit and looped back to
the Source Unit.

—
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Loopback Test

Testing Your Units

E Configuration Program

File Edit Command: “iew Help

[ %

CEIBEHYY @

| B A | I oco 0 oR| (B ATs[I crs| [ 0sR| I Conmendiioe RIS I fidHe @ Comnected

Terminal Mode I Serial Settings
General I Advanced Settings

I Special Features
Loopback Test

Thiz test requires the Remote unit to have a loopback connector
attached to the zerial port.

— Test stiing

IThis is a test

Fepeat every I‘IDDD msec
Timeout |2 seC

Repeat IU times [0 = infinite]

" Test & [hstantaneaus HE50
) Lyerane HEE

i
e]ez]

05

T Fowern [Discret Ehart]

g

RX Pane

This iz a testThis iz a testThis is a testThis is a testThis is a testThis iz a testThis is a
testThis is & testThis is a testThis iz a testThis is a testThis is a testThis is a testThis iz a
testThis is a testThis iz a test

e

=

TX Pane

Faor Help, press F1

This iz a testThis iz a testThis is a testThis is a testThis is a testThis iz a testThis is a
testThiz is & testThis is a testThis iz a testThis is a testThis is a testThis is a testThis iz a
testThis is a testThis iz a test

=

[]

CAP [NUM |Saturday, March 27, 99 [03:27 PM

4

The RX Pane shows the test string as received by the transceiver
connected to the computer after being loopbacked from the remote

transceiver. If no datais received within the timeout period the message
ITimeout! isprinted in the RX Pane. The TX Pane shows the test string as

typed in the dialogue box.

To test the placement of a unit:

P wbdpE

—
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Click the Loopback Test tab.
Click Test.
Click Instantaneous RSSI.

In Test String, enter some text.

Enter the desired criteria in other fields in this group.

The default values are recommended for this type of testing.
Click Start.




Viewing Data In The Rx And Tx

Testing Your Units

6. Move one or both units until the greatest RSSI values for local and remote
are achieved. The optimization of the unit placement does not have to be
too exact. An RSSI value above the half mark is acceptable.

E Configuration Program

File Edit Command: “iew Help

75 |osdBE YT e

J B 7 @ o | o) [ rrs|E ots| B psA| T Commendiiade MIRTS I fHer @ Connested
Terminal Mode I Serial Settings I Special Features | RX Pane
General I Advanced Settings Loopback Test

This iz a testThis iz a testThis is a testThis is a testThis is a testThis iz a testThis is a ;I
testThis is a testThis iz a test

Thiz test requires the Remote unit to have a loopback connector
attached ta the serial port.

— Test stiing

IThis is a test

Fepeat every I‘IDDD msec
Repeat IU times [0 = infinite]

Timeout |2 seC I-]
TX Pane
IV Test @ Instantaneaus RSSI This iz a testThis iz a testThis is a testThiz is a testThis is a testThis iz a testThis is a ;I
™ Average R3S testThis is a testThis iz a test
a 05 1
Local
T Power [Discret Chart] N
For Help, press F1 LM |Saturday, March 27,99 (0331 PM 2

VIEWING DATA IN THE RX AND TX PANES

tests. The RX panes shows data being received into the transceiver. The
TX pane shows data being transmitted from the transceiver. All data sent
Q E:::F will be displayed and at times the pane may become cluttered. Y ou can

E R‘:i These display areas show the data being transmitted and received during

use the Clear buttons on the toolbar or the commands in the Edit menu to
clear the panes of data. To clear datain the panes, select Clear RX Pane or
Clear TX Pane.
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Using Hyperterminal

Testing Your Units

USING HYPERTERMINAL

On every Windows system there is aterminal program called
HyperTerminal. The following instructions show how to use
HyperTerminal to test data communication for Point to Point or Multi-
point networks.

To use Hyperterminal

1. Select Start> Program Files> Accessories> Communications>
HyperTerminal.

2. Double-click HyperTerminal.exe.
The main window appears with a session window active.

3. Enter a name for this session and click the first icon (red and yellow
telephones).

4. Click OK.
The Connect To window appears.

5. Select a connection option.

6. For Point to Point and ComPort Intercept select the direct Com port. (This
isthe COM Port used to connect the transceiver in the Configuration

Manager). Fill out the serial settings to match what you have set in the
Configuration Manager.

For TCP/IP select TCP/IP(winsock).
7. Enter the Begin Typing and watch for the results.

Note: If you type but do not see the characters on screen and wish to see them,
select File> Properties> Settings> ASCII setup> Echo Typed Characters
Locally.

Note: If you aretesting Multi-Point or Repeater with ComPort Intercept or TCP/
IP Intercept their Activators must be running.

—
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Chapter 9: Troubleshooting

Problem

Possible Cause

Possible Solution

L]

“(?) Timeout” messages are
displayed in the
Configuration Manager
general tab fields.

Antenna cannot be threaded
onto the antenna connector.

In Network modealink gets

stuck on—that is, LEDs1 &
2 stay lit.

LED 1 not lit

LED land LED 2 flashes 3
times

Open the Configuration
Manager and get an error
message

Point to Point or remote
transceiver in anetwork is
malfunctioning with a9
wire cable

The equipment is not
connected properly.

Wrong serid portis
selected.

Antenna and antenna
connector have “left-
handed” threads.

The application program
running on the host PC is
writing to the physical
COM port whichis
attached to the host
transceiver, instead of
writing to avirtual COM
port.

Power is not being
supplied to unit.

Normal operation.

Outdated DLL.

The device to which the
transceiver is connected
is activating the pin
utilized by the Zeus

Network Software Utility.

Check that all connections are
secure. Make sure transceiver has
power (LED 1islit).

Select the correct serial port inthe
Serial tab of the Configuration
Manager.

Turn antenna connector counter-
clockwise to attach to transceiver.

Power off the host transceiver and
ensure that the mapping of virtual
COM portsto a physical COM
port is correct. Make sure that the
ComPort Activator is running.
Make sure that the application
program is not writing data to the
PC’s physical COM port which is
attached to the transceiver.

Check power supply connection
into unit and outlet. Make sure
supply of power is active.

No need to troubleshoot.

Run 401COMUPD..exe included
in program disk to install
COMCTL32.DLL inyour
C:\Windows\System directory.

Try replacing the 9 wire cable
witha5wirecable. If thiscorrects
the problem, utilize the 5 wire
cable.

1

Problem

Possible Cause

Solution

In this Chapter
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Troubleshooting

Problem Possible Cause Possible Solution

The Configuration Program ~ ComPort or TCP/IP Suspend or unload Activators

will not start Activator program is when using the Configuration
running in the Program to make changes.
background.

Unitisbeing sent databutis  Power mode settings Use Configuration Manager to

not receiving (dleep) can prevent the place unit in normal power mode.

transfer of data.
User applications report a Longer data propagation Increase the period that the user

“timeout” while waiting for ~ delay compared with application waits before declaring
aresponse from another cable. a“timeout.” (Suggest 1500 to
user-supplied device (e.g. 2000 msec.)

printer or computer)

connected to the remote

transceiver.
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Chapter 10: Learning Exercises

The following exercises guide you through the stepsof  In this Chapter
the setup, configuration, and test for Point to Pointand . pgint to Point
Network wireless operation. These procedures rely on
the assumptions that you have adequate power,
peripherals, and host devices.

e ComPort
Intercept

Note: These procedures are written for Stand-alone Models.

POINT TO POINT

T This exercise provides a demonstration of all the steps
' ' needed to have a direct wireless communication
@ﬂ between two transceivers.

Materials Needed

e 1PC
e 2 transceivers
« 2 Antennas

e 2 Power sources (outlet and/or surge strips) and 2
power supplies for transceivers

* 1 other peripheral (must have a RS232 connector)
» Configuration Manager software
e 2 RS-232 cables

Procedure

Install Software

1. Power up your PC.

1
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Point to Point

Learning Exercises
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10.

11.

12.

13.
14.
15.

Insert the Configuration Manager CD into the appropriate drive.

Using your usual method (Windows Explorer, My computer etc.) to view
the contents of the drive.

Double-click Setup.exe.
Follow the on screen instructions to complete the installation.

Connect the Transceiver

Attach the power supply to transceiver 1.
Plug the power supply into power source.

Verify that LED 1 on the front panel of the transceiver blinks 3 times and
remains lit.

Attach an antenna to transceiver 1.

Insert the RS232 cable connector into the serial connector in the back of
the transceiver.

Attach the other end of this cable into the serial port on the back of your
computer.

Configure Transceiver 1

Select Configuration Manager form the Start menu in Windows.
The Main window appears.

Click Quick Configuration.

Click Point-to-Point.

Click OK.




Point to Point

16.

17.

18.
19.

20.
21.
22.

23.
24,
25.

26.
27.

Learning Exercises

Enter the information as shown in the dialog below.

‘Point To Point® Unit Settings E
Metwork 1D |4

Alias Metwork Mame  [METWORK 4
Source Unit D |0

Aliaz Source Mame |Device 1

Destination |0 ID
Hop Table I 'l S O
— Serial Setting:

R ate.Parity... 9E00.8.M.1
Flows Contral Mone Change |
GFI0 Mode Disabled

Subrmit I Cancel |

Click Submit.

Generate a Report (if desired)

Click Report Generation.
Click Close.

Connect and Configure Transceiver 2

Click OK.
Click OK to configure another Unit.

Disconnect serial connector from transceiver 1. (You can leave it on the
computer.)

Attach power supply to transceiver 2.
Plug power supply into power source.

Verify that LED 1 on the front panel of the transceiver blinks three times
and remains lit.

Attach an antenna to transceiver 2.

Insert the RS232 connector into the serial connector in the back of the
transceiver.

—
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Point to Point

Learning Exercises

Note that all of the fields are grayed out except Alias Source name.

‘Point To Point® Unit Settings E
Metwork 1D |4

Alias Metwork Mame  |[METWORE 4

Source Unit 1D |0

Aliag Source Mame |Device 2

Destination |0 ID
HopTable [5 =] | £ 1% & A%
— Serial Setting:

R ate.Parity... 9E00.8.M.1
Flows Contral Mone Change |
GFI0 Mode Disabled

Subrmit I Cancel |

28. Click Submit.
29. Uncheck Report Generation.
30. Click Close.

View the Report

31. In your Windows Explorer, open C:\Program Files\Configuration
Manager\RReport.txt.

Test Operation
32. Connect transceiver 1 to a peripheral device. Note power supply,
connector and antenna connections must all be made.

33. On the Host PC, Click the Terminal Mode tab in the Configuration
Manager.

34. In Test String, enter some text.

Thetest string is transmitted to the Destination Unit as shown in the TX
and RX panes.

35. Select Exit from the File menu.

=—
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Multi-Point ComPort Intercept

Learning Exercises

MULTI-POINT COMPORT INTERCEPT

e

RN

This exercise demonstrates how you can have three transceivers
configured on asmall Multi-Point Network communicate without wire.
This network topology can support up to 16 transceivers (including one at
the Host PC).

Materials Needed
= *  1HostPC

» 3 Transceivers
¢ 3 Antennas

» 2-3 Power sources (outlet and/or surge strips) and 3 power supplies
for transceivers

e 2 other peripherals (must have a RS232 connector)
» Configuration Manager software

e ComPort Intercept software

3 RS232 cables

Procedure

36.
37.
38.

39.
40.
41.
42.

43.
44,

Install Software

Power up your Host PC.
Insert the Configuration Manager software into the appropriate drive.

Using your usual method (Windows Explorer, My computer etc.) view the
contents of the drive.

Double-click Setup.exe.
Follow the on screen instructions to complete the installation.
Insert the ComPort Intercept Software into the appropriate drive.

Using your usual method (Windows Explorer, My computer etc.) to view
the contents of the drive.

Double-click Setup.exe.
Follow the on screen instructions to complete the installation.

—
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Multi-Point ComPort Intercept

Learning Exercises
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45,
46.
47.

48.
49.

50.

51.
52.
53.

54,
55.

56.

57.

Connect the Transceiver

Attach the power supply to transceiver 1.
Plug the power supply into power source.

Verify that LED 1 on the front panel of the transceiver blinks 3 times and
remains lit.

Attach an antenna to transceiver 1.

Insert the RS232 cable connector into the serial connector in the back of
the transceiver.

Attach the other end of this cable into the serial port on the back of your
Host PC.

Configure Transceiver 1

Select Configuration Manager from the Start menu in Windows.
The Main window appears.

Click Quick Configuration.

Click Host to Multi-Point (Host)

Click OK.

Enter the information as shown in the dialog below.

‘Host To Multipoint (Host)" Unit Settings E

Metwark |D IE!
Alias Metwark INETW’DHK 4

Source Unit D |0
Alias Source Name [HOSt

Destination |0 |1
HopTable [5 =] | £ 04 & Ax

— Serial Setting:

R ate.Parity... 9E00.8.M.1
Flows Contral Hardware Change |
GFI0 Mode Disabled

Subrmit I Cancel |

Click Submit.

Generate a Report (if desired)

Click Report Generation.




Multi-Point ComPort Intercept

58.

59.
60.
61.

62.
63.
64.

65.
66.

67.
68.
69.

Learning Exercises

Click Close.

Connect and Configure Transceiver 2

Click Yes.
Click OK.

Disconnect serial connector from transceiver 1. (You can leave it on the
computer.)

Attach power supply to transceiver 2.
Plug power supply into power source.

Verify that LED 1 on the front panel of the transceiver blinks three times
and remains lit.

Attach an antenna to transceiver 2.

Insert the RS232 connector into the serial connector in the back of the
transceiver.

Note that all of the fields are grayed out except Alias Source name and
Source Unit ID.

‘Host To Multipoint [Remote]’ Unit Settings E

Metwark |D I
Aliaz Metwork INETWDHK 4

Source Unit D |1
Aliag Source Mame |FEMOTE 1

Destination ID
HopTable [5 =] | £ 1% & A%
i~ Serial Setting
Fiate Parity... SE00.8.4.1

Flow Control MNane Change |
GFI0 Mode Disabled

¥ Auto Incremet

Subrmit I Cancel |

Make sure that Auto increment is checked.
Click Submit.

Uncheck Report Generation.

Click Close.

—
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Multi-Point ComPort Intercept

Learning Exercises
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70.
71.

72.
73.
74.
75.
76.

77.
78.
79.
80.
81.

82.

83.

84.
85.

86.
87.
88.
89.

Connect and Configure Transceiver 3

Click OK.

Disconnect serial connector from transceiver 2. (You can leave it on the
computer.)

Attach power supply to transceiver 3.

Plug power supply into power source.

Verify that LED 1 on the front panel of the transceiver remains lit.
Attach an antenna to transceiver 3.

Insert the RS232 connector into the serial connector in the back of the
transceiver.

Note that all of the fields are grayed out except Alias Source name and
Source Unit ID. Make sure that Auto Increment is checked.

Click Submit.

Check Report Generation.
Click Close.

Click Cancel.

Select Exit from the File menu.

View the Report

In your Windows Explorer, open C:\Program Files\Configuration
Manager\RReport.txt.

Set up Virtual Ports

Select ComPort Configurator from the Start Menu under ComPort
Intercept.

The Comport Configurator Main Window appears.

Click the Add Virtual Ports Icon.

Enter 2 and click OK.

A message appears asking to restart your computer.

Click No.

In the Virtual ports window, right-click the first listed Virtual port.
Click Assign Unit ID.

Enter 1 and click OK.

Thiswill be assigned to the remote called Device 1.




Multi-Point ComPort Intercept

90
91
92

Note:

93.
94,

95.
96.
97.

98.

99.

Note:

Learning Exercises

. Right-click the second virtual port.

. Click Assign Unit ID.

. Enter 2 and click OK.

Thiswill be assigned to the remote called Device 2.

The host deviceis not assigned to avirtual port asit is physically
connected to the Host PC.

Highlight both virtual ports.

Drag them to the physical Port window under Comm Port 1.

Note that thisis most likely your comm port but others may be listed.
Click Exit to exit the ComPort Intercept program.

Restart your computer.

Select Start then Programs and then Comport Activator.

Test Operation

Connect transceivers 2 and 3 to peripheral devices. Note power supply,
connector, and antenna connections must all be made.

Transceiver 1 must remain connected to the Host PC.
Send data from the Host PC to a peripheral device.

For example, if you had a printer (with a serial connection) that you have
been using (i.e., drivers are already set up) you could write a short memo
inaword processor on the Host PC and select File>print. Theinformation
would be printed out on the printer just asif it had been connected by

wire. Thiswould work for any existing wired connection on alocal LAN.

Another example would be to use HyperTerminal. This requires that your
peripherals are also PCs or that you use aloop back connector to see the
data sent returned in your HyperTerminal Window.

If you are using hyperterminal, remember to connect the Virtual Port
number and not the physical port number (COM1). You will need to open
two HyperTerminals to connect to both remote transceivers at the same
time.

—
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Multi-Point TCP/IP Intercept

Learning Exercises

MULTI-POINT TCP/IP INTERCEPT

This exercise demonstrates how you can have 3 transceivers configured
e on a TCP/IP based Multi-Point network communicating without wire.

e e

2 e .
m s e Materials Needed

_‘ o e 1 HostPC

@| ( > » 3 Transceivers
. e 3 Antennas
e 2-3 Power sources (outlet and/or surge strips) and 3 power supplies
for transceivers
e 2 other peripherals (must have a RS232 connector)
e Configuration Manager software
*  TCP/IP Intercept software

e 3 RS232 cables

Procedure

Install Software

100.Power up your Host PC.
101.Insert the Configuration Manager software into the appropriate drive.

102.Using your usual method (Windows Explorer, My computer etc.) view the
contents of the drive.

103.Double-click Setup.exe.
104.Follow the on screen instructions to complete the installation.
105.Insert the TCP/IP Intercept software into the appropriate drive.

106.Using your usual method (Windows Explorer, My computer etc.) view the
contents of the drive.

107.Double-click Setup.exe.
108.Follow the on screen instructions to complete the installation.

Connect the Transceiver
109.Attach the power supply to transceiver 1.
110.Plug the power supply into power source.

—
f=m Transceiver User’s Manual

100



Multi-Point TCP/IP Intercept

Learning Exercises

111.Verify that LED 1 on the front panel of the transceiver blinks 3 times and
remains lit.

112.Attach an antenna to transceiver 1.

113.Insert the RS232 cable connector into the serial connector in the back of
the transceiver.

114.Attach the other end of this cable into the serial port on the back of your
Host PC.

Configure Transceiver 1

115.Select Configuration Manager form the Start menu in Windows.
The Main window appears.

116.Click Quick Configuration.

117.Click Host to Multi-Point (Host).

118.Click OK.

119.Enter the information as shown in the dialog below.

‘Host To Multipoint (Host)" Unit Settings E

Metwark |D IE!
Alias Metwark INETW’DHK 4

Source Unit D |0

Aliaz Source Mame |Device 1

Destination |0 |1
HopTable [5 =] | £ 04 & Ax
— Serial Setting:

R ate.Parity... 9E00.8.M.1
Flows Contral Hardware Change |
GFI0 Mode Disabled

Subrmit I Cancel |

120.Click Submit.

Generate a Report (if desired)

121.Click Report Generation.
122.Click Close.

123.Click Yes.
124.Click OK.
H
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Multi-Point TCP/IP Intercept

Learning Exercises
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Connect and Configure Transceiver 2

125.Disconnect serial connector from transceiver 1. (You can leave it on the
computer.)

126.Attach power supply to transceiver 2.

127.Plug power supply into power source.

128.Verify that LED 1 on the front panel of the transceiver blinks three times
and remains lit.

129.Attach an antenna to transceiver 2.

130.Insert the RS232 connector into the serial connector in the back of the
transceiver.

Note that all of the fields are grayed out except Alias Source name and
Source Unit ID.

‘Host To Multipoint [Remote]’ Unit Settings E

Metwark |D I
Alias Metwark INETW’DHK 4

Source Unit D |1
Aliag Source Mame |FEMOTE 1

Destination ID
HopTable [5 =] | £ 1% & A%

— Serial Setting:

Fiate Parity... 9600.8.M.1
Flow Control MNane Change |
GFI0 Mode Disabled

¥ Auto Incremet

Subrmit I Cancel |

Make sure that Auto Increment is checked.
131.Click Submit.
132.Uncheck Report Generation.
133.Click Close.

Connect and Configure Transceiver 3

134.Click OK.

135.Disconnect serial connector from transceiver 2. (You can leave it on the
computer.)

136.Attach power supply to transceiver 3.




Multi-Point TCP/IP Intercept

Learning Exercises

137.Plug power supply into power source.
138.Verify that LED 1 on the front panel of the transceiver remains lit.
139.Attach an antenna to transceiver 3.

140.Insert the RS232 connector into the serial connector in the back of the
transceiver.

Note that all of the fields are grayed out except Alias Source name and
Source Unit ID. Make sure that Auto increment is checked.

141.Click Submit.

142.Check Report Generation.
143.Click Close.

144.Click Cancel.

145.Select Exit from the File menu.

View the Report

146.In your Windows Explorer, open C:\Program Files\Configuration
Manager\RReport.txt.

Set up TCP/IP Ports
147.Select Start> Programs> TCP/IP Intercept Program.

Note: If you receive a message requesting you set up TCP/IP ports, click OK.
148.Right-click the TCP/IP Activator icon in the lower right corner of your
Desktop.
149.Select Show Configurator.
The TCP/IP Configurator Main Window appears.
150.Click the Add TCP/IP Ports Icon.
151.Enter 2 and a start from value.

The value here refers to your machines TCP/IP port number. values range
from 1024 to 10,000.

make sure that the value in the units section is 1.
152.Click OK.
Unit IDs are automatically assigned.
153.Highlight both virtual ports.
154.Drag them to the Physical Port window under COM Port 1.

—
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Multi-Point TCP/IP Intercept

Learning Exercises

Note that thisis most likely your COM port but others may be listed.

155.Click Hide to hide the TCP/IP Configurator and keep the Activator
running.

Test Operation

156.Connect transceivers 2 and 3 to peripheral devices. Note power supply,
connector, and antenna connections must all be made.

Transceiver 1 must remain connected to the Host PC.

157.Send data from the Host PC to a peripheral device.
For example, if you had a printer (with aserial connection) that you have
been using (i.e., drivers are already set up) you could write a short memo
in aword processor on the Host PC and select File>print. The information
would be printed out on the printer just asif it had been connected by
wire. Thiswould work for any existing wired connection on alocal LAN.
Another example would be to use HyperTerminal. This requires that your
peripherals are a'so PCs or that you use aloop back connector to see the
data sent returned in your HyperTerminal Window.

—
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Repeater TCP/IP Intercept

Learning Exercises

REPEATER TCP/IP INTERCEPT

This exercise demonstrates how you can have 3 transceivers configured
on a TCP/IP based Repeater network communicating without wire.

Materials Needed

e 1 HostPC
e 3 Transceivers

» 3 Power sources (outlet and/or surge strips) and 3 power supplies for
transceivers

e 1 other peripherals (must have a RS232 connector)
» Configuration Manager software

e TCPI/IP Intercept software

3 RS232 cables

* 1 loopback connector

Procedure

Install Software

158.Power up your Host PC.
159.Insert the Configuration Manager software into the appropriate drive.

160.Using your usual method (Windows Explorer, My computer etc.) view the
contents of the drive.

161.Double-click Setup.exe.
162.Follow the on screen instructions to complete the installation.
163.Insert the TCP/IP Intercept software into the appropriate drive.

164.Using your usual method (Windows Explorer, My computer etc.) view the
contents of the drive.

165.Double-click Setup.exe.
166.Follow the on screen instructions to complete the installation.

Connect the Transceiver
167.Attach the power supply to transceiver 1.
168.Plug the power supply into power source.

F-’I )
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Repeater TCP/IP Intercept

Learning Exercises

169.Verify that LED 1 on the front panel of the transceiver blinks 3 times and
remains lit.

170.Insert the RS232 cable connector into the serial connector in the back of
the transceiver.

171.Attach the other end of this cable into the serial port on the back of your
Host PC.

Configure Transceiver 1

172.Select Configuration Manager form the Start menu in Windows.
The Main window appears.

173.Click Quick Configuration.

174.Click Repeater (Host).

175.Click OK.

176.Enter the information as shown in the dialog below.

‘Repeater [Host])' Unit Settings E

Metwork 1D |4
Alias Metwork  |NETWOREK 4
Source Unit D |0

Aligs Source Mame |Device Hosf

Destination |0 |1
HopTable [0 =] | £ 04 & Hx
— Serial Setting:

R ate.Parity... 9E00.8.M.1
Flows Contral Hardware Change |
GFI0 Mode Disabled

Subrmit I Cancel |

177.Click Submit.

Generate a Report (if desired)

178.Click Report Generation.
179.Click Close.

180.Click Yes.

181.Click OK.
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Repeater TCP/IP Intercept

Learning Exercises

Connect and Configure Transceiver 2

182.Disconnect serial connector from transceiver 1. (You can leave it on the
computer.)

183.Attach power supply to transceiver 2.
184.Plug power supply into power source.

185.Verify that LED 1 on the front panel of the transceiver blinks three times
and remains lit.

186.Insert the RS232 connector into the serial connector in the back of the
transceiver.

Note that all of the fields are grayed out except Alias Source name and
Source Unit ID.

‘Repeater [Remote]’ Unit Settings E

Metwark |D I
Alias Metwark INETW’DHK 4

Source Unit D |1
Aliag Source Mame |FEMOTE 1

Destination ID
HopTable [0 =] | € 1% & A%

— Serial Setting:

Fiate Parity... SE00.8.4.1
Flow Control MNane Change |
GFI0 Mode Disabled

¥ Auto Incremet

Subrmit I Cancel |

Make sure that Auto Increment is checked.
187.Click Submit.
188.Uncheck Report Generation.
189.Click Close.

Connect and Configure Transceiver 3

190.Click OK.

191.Disconnect serial connector from transceiver 2. (You can leave it on the
computer.)

192.Attach power supply to transceiver 3.
193.Plug power supply into power source.

H
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Learning Exercises

194 .Verify that LED 1 on the front panel of the transceiver remains lit.

195.Insert the RS232 connector into the serial connector in the back of the
transceiver.

Note that all of the fields are grayed out except Alias Source name and
Source Unit ID. Make sure that Auto increment is checked.

196.Click Submit.

197.Check Report Generation.
198.Click Close.

199.Click Cancel.

200.Select Exit from the File menu.

View the Report

201.In your Windows Explorer, open C:\Program Files\Configuration
Manager\RReport.txt.

Set up TCP/IP Ports

202.Select Start> Programs> TCP/IP Intercept Program.

Note: If you receive a message requesting you set up TCP/IP ports, click OK.

203.Right-click the TCP/IP Activator icon in the lower right corner of your
Desktop.

204.Select Show Configurator.
The TCP/IP Configurator Main Window appears.

205.Click the Add TCP/IP Ports Icon.

206.Enter 1 and a start from value.

Thevalue here refersto your machines TCP/IP port number. Values range
from 1024 to 10,000.

Make sure that thevalue in the units section is 1.

Thisisthe configuration of the port that will be used to send data to
Transceiver 3.

207.Click OK.
Unit IDs are automatically assigned.
208.Highlight the virtual port.
209.Drag them to the Physical Port window under COM Port 1.
Note that thisis most likely your COM port but others may be listed.
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Learning Exercises

210.Click Hide to hide the TCP/IP Configurator and keep the Activator
running.

Test Operation

211.Connect transceiver 2 to power only.
Transceiver 1 must remain connected to the Host PC.

212.Place a loopback connector and power on transceiver 3.

213.Send data from the Host PC to transceiver 3.
For example, if you had a printer (with a serial connection) that you have
been using (i.e., drivers are already set up) you could write a short memo
inaword processor on the Host PC and select File>print. Theinformation
would be printed out on the printer just asif it had been connected by
wire. Thiswould work for any existing wired connection on alocal LAN.
Another example would be to use HyperTerminal. This requires that your
peripherals are also PCs or that you use aloop back connector to see the
data sent returned in your HyperTerminal Window.

Note: You can not use the Loopback test in Configuration Manager, it will
conflict with TCP/IP Activator.

214.Unplug transceiver 3 and move significantly away from transceiver 1.
Plug-into power.

215.Resend data. If data is received, repeat moving away and resending until
you receive a time out message.

216.Move transceiver 2 and resend data to transceiver 3 until data is again
received.

217.Connect transceiver 3 to peripheral devices. (Note power supply and
connector connections must be made.)

218.Resend data.

Instead of being looped back, datais received on the peripheral attached
to transceiver 3.

—
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Learning Exercises

BROADCAST REMOTE-TO-ALL

This exercise demonstrates how you can have 3 transceivers configured
on a Broadcast Network communicating without wire.

Materials Needed

e 1 HostPC
e 3 Transceivers

» 3 Power sources (outlet and/or surge strips) and 3 power supplies for
transceivers

e 3 antennas

e 2 smart peripherals (must have a RS232 connector and be able to
produce output (i.e, laptop))

e Configuration Manager software
3 RS232 cables

Procedure

Install Software

1. Power up your Host PC.
Insert the Configuration Manager software into the appropriate drive.

Using your usual method (Windows Explorer, My computer etc.) view the
contents of the drive.

Double-click Setup.exe.
Follow the on screen instructions to complete the installation.
Insert the TCP/IP Intercept software into the appropriate drive.

Using your usual method (Windows Explorer, My computer etc.) view the
contents of the drive.

Double-click Setup.exe.
9. Follow the on screen instructions to complete the installation.

w N

N o g ks

0

Connect the Transceiver

10. Attach the power supply to transceiver 1.
11. Plug the power supply into power source.
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Broadcast Remote-To-All

12.

13.

14.

15.

16.
17.
18.
19.

20.

Learning Exercises

Verify that LED 1 on the front panel of the transceiver blinks 3 times and
remains lit.

Insert the RS232 cable connector into the serial connector in the back of
the transceiver.

Attach the other end of this cable into the serial port on the back of your
Host PC.

Configure Transceiver 1

Select Configuration Manager form the Start menu in Windows.
The Main window appears.

Click Quick Configuration.

Click Broadcast (Host).

Click OK.

Enter the information as shown in the dialog below.

‘Broadcast [Host])' Unit Settings E

Metwark |D IE!
Alias Metwark INETW’DHK 4

Source Unit D |0

Aliaz Source Mame |['evice Host
Destination |0 I‘I—
Hop Table |u = [EI5EIER
— Serial Setting:
Fiate Parity... SE00.8.4.1

Flows Contral Hardware Change |
GFI0 Mode Disabled

Subrmit I Cancel |

Click Submit.

Generate a Report (if desired)

21. Click Report Generation.
22. Click Close.
23. Click Yes.
24. Click OK.
25. Click Remote to All.
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26.

27.
28.
29.

30.

31.
32.
33.

34.
35.

36.
37.

Connect and Configure Transceiver 2

Disconnect serial connector from transceiver 1. (You can leave it on the
computer.)

Attach power supply to transceiver 2.

Plug power supply into power source.

Verify that LED 1 on the front panel of the transceiver blinks three times
and remains lit.

Insert the RS232 connector into the serial connector in the back of the
transceiver.

Note that all of the fields are grayed out except Alias Source name and
Source Unit ID.

‘Broadcast [Remote -> All)' Unit Settings E

Metwork 1D |4
Alias Metwork  |NETWOREK 4

Source Unit D |1
Aliag Source Mame |FEMOTE 1

Destination ID
HopTable [0 =] | £ 04 & Hx

— Serial Setting:

Fiate Parity... SE00.8.4.1
Flow Control MNane Change |
GFI0 Mode Disabled

Submit | Carcel |

Make sure that Auto Increment is checked.
Click Submit.

Uncheck Report Generation.

Click Close.

Connect and Configure Transceiver 3

Click OK.

Disconnect serial connector from transceiver 2. (You can leave it on the
computer.)

Attach power supply to transceiver 3.
Plug power supply into power source.




Broadcast Remote-To-All

38.
39.

40.
41.
42.
43,
44,

45,

46.

47.

48.

Learning Exercises

Verify that LED 1 on the front panel of the transceiver remains lit.

Insert the RS232 connector into the serial connector in the back of the
transceiver.

Note that all of the fields are grayed out except Alias Source name and
Source Unit ID. Make sure that Auto increment is checked.

Click Submit.

Check Report Generation.
Click Close.

Click Cancel.

Select Exit from the File menu.

View the Report

In your Windows Explorer, open C:\Program Files\Configuration
Manager\RReport.txt.

Test Operation

Connect transceivers 2 and 3 to peripheral devices. (Note power supply,
connector, and antenna connections must all be made.)

Transceiver 1 must remain connected to the Host PC.

Send data from the host pc to a peripheral device.

An example would be to use HyperTerminal. This requires that your
peripherals are aso PCs or that you use aloop back connector to see the
data sent returned in your HyperTerminal Window.

The data appears on both peripheral at once.

Send data from the peripheral device to a the host.

The data appears on the Host and on the other peripheral device.

—
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Learning Exercises

BROADCAST REMOTE-TO-HOST
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This exercise demonstrates how you can have 3 transceivers configured
on a broadcast network communicating without wire.

Materials Needed

e 1 HostPC
e 3 Transceivers

» 3 Power sources (outlet and/or surge strips) and 3 power supplies for
transceivers

e 3 antennas

e 2 smart peripherals (must have a RS232 connector and be able to
produce output (i.e, laptop))

e Configuration Manager software
3 RS232 cables

Procedure

w N

N o g ks

0

Install Software

Power up your Host PC.
Insert the Configuration Manager software into the appropriate drive.

Using your usual method (Windows Explorer, My computer etc.) view the
contents of the drive.

Double-click Setup.exe.
Follow the on screen instructions to complete the installation.
Insert the TCP/IP Intercept software into the appropriate drive.

Using your usual method (Windows Explorer, My computer etc.) view the
contents of the drive.

Double-click Setup.exe.
Follow the on screen instructions to complete the installation.

Connect the Transceiver

10. Attach the power supply to transceiver 1.
11. Plug the power supply into power source.




Broadcast Remote-To-Host

12.

13.

14.

15.

16.
17.
18.
19.

20.

Learning Exercises

Verify that LED 1 on the front panel of the transceiver blinks 3 times and
remains lit.

Insert the RS232 cable connector into the serial connector in the back of
the transceiver.

Attach the other end of this cable into the serial port on the back of your
Host PC.

Configure Transceiver 1

Select Configuration Manager form the Start menu in Windows.
The Main window appears.

Click Quick Configuration.

Click Broadcast (Host).

Click OK.

Enter the information as shown in the dialog below.

‘Broadcast [Host])' Unit Settings E

Metwark |D IE!
Alias Metwark INETW’DHK 4

Source Unit D |0

Aliaz Source Mame |['evice Host
Destination |0 I‘I—
Hop Table |u = [EI5EIER
— Serial Setting:
Fiate Parity... SE00.8.4.1

Flows Contral Hardware Change |
GFI0 Mode Disabled

Subrmit I Cancel |

Click Submit.

Generate a Report (if desired)

21. Click Report Generation.
22. Click Close.
23. Click Yes.
24. Click OK.
25. Click Remote to Host.
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26.

27.
28.
29.

30.

31.
32.
33.

34.
35.

36.
37.

Connect and Configure Transceiver 2

Disconnect serial connector from transceiver 1. (You can leave it on the
computer.)

Attach power supply to transceiver 2.

Plug power supply into power source.

Verify that LED 1 on the front panel of the transceiver blinks three times
and remains lit.

Insert the RS232 connector into the serial connector in the back of the
transceiver.

Note that all of the fields are grayed out except Alias Source name and
Source Unit ID.

‘Broadcast [Remote -> Host)' Unit Settings E

Metwark |D I
Alias Metwark INETW’DHK 4

Source Unit D |1
Aliag Source Mame |FEMOTE 1

Destination ID
HopTable [0 =] | € 1% & A%
i~ Serial Setting
Fiate Parity... SE00.8.4.1

Flow Control MNane Change |
GFI0 Mode Disabled

¥ Auto Incremet

Subrmit I Cancel |

Make sure that Auto Increment is checked.
Click Submit.

Uncheck Report Generation.

Click Close.

Connect and Configure Transceiver 3

Click OK.

Disconnect serial connector from transceiver 2. (You can leave it on the
computer.)

Attach power supply to transceiver 3.
Plug power supply into power source.




Broadcast Remote-To-Host

38.
39.

40.
41.
42.
43,
44,

45,

46.

47.

48.

Learning Exercises

Verify that LED 1 on the front panel of the transceiver remains lit.

Insert the RS232 connector into the serial connector in the back of the
transceiver.

Note that all of the fields are grayed out except Alias Source name and
Source Unit ID. Make sure that Auto increment is checked.

Click Submit.

Check Report Generation.
Click Close.

Click Cancel.

Select Exit from the File menu.

View the Report

In your Windows Explorer, open C:\Program Files\Configuration
Manager\RReport.txt.

Test Operation

Connect transceivers 2 and 3 to peripheral devices. Note power supply,
connector, and antenna connections must all be made.

Transceiver 1 must remain connected to the Host PC.

Send data from the host pc to a peripheral device.

An example would be to use HyperTerminal. This requires that your
peripherals are aso PCs or that you use aloop back connector to see the
data sent returned in your HyperTerminal Window.

The data appears on both peripheral at once.

Send data from the peripheral device to a the host.

The data appears on the Host but not on the other peripheral device.
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Glossary

ActiveX Library
Asymmetrical Data Rates

Automatic-repeat-request
(ARQ)
Broadcast Network

Buffer

Carrier Sense Multiple
Access (CSMA)

ComPort Activator
ComPort Configurator
ComPort Intercept
Configuration Manager
dBi

Design-in Transceiver
Device

Direct Sequence Spread
Spectrum (DSSS)

Directional Antenna
DOS Library

Ethernet

Forward-error-correction
(FEC)

A Network Software Utility used to develop custom applications.

The ability to send datain different directions at varying data rates
which accommodates large data transfers.

A protocol which helps maintain data integrity.

A type of Host to Multi-Point Network. A network topology.
A collection station for data.
A protocol used for communication between transceivers.

The driver part of ComPort Intercept.

The application part of ComPort Intercept.

A Network Software Utility used for networks with up to 16 devices.
Name of the program used to configure all Transceivers.

A ratio of decibels to an isotropic antennathat is commonly used to
measure antenna gain. The greater the dBi value, the higher the gain
and, as such, the more acute the angle of coverage.

A type of Zeus Transceiver. Integrated into OEM products.
Refers to customer equipment, peripheral, nodes.

A type of spread spectrum radio transmission that spreads its signal
continuously over awide frequency band

An antenna with range extended in a particular direction.

A Network Software Utility to port Zeus software to controllers and
embedded microprocessors that are not Windows PCs.

A type of data transmission technology that enables LAN/WANS,
Internet, and Intranet connectivity.

An agorithm which corrects and retransmits erroneous data.

—

f==  Transceiver User's Manual

G-1



Glossary

Frame

Frequency Hopping
Spread Spectrum (FHSS)

Gain

GigaHertz (GHz)
GPIO

Hardware Key

Hertz(Hz)
Hop Table

Host

Host PC

ITU cyclical redundancy
code 16 CRC-16

Line of Sight
Link

Loopback Connector
Master

MegaHertz (MHz)
Multi-Point Network

Network Software Utilities
Network Topology

Term for the smallest unit of data being transmitted. The physical
data packet.

A type of spread spectrum radio transmission that hops, in a
prearranged pattern, through a prescribed frequency band.

A method accomplished by an antenna of increasing signal strength
by concentrating asignal in asingle direction. The higher the gain
the longer the distance of transmission.

A unit of measure for frequency. Billions of Cycles per second.
A feature which enables General Purpose Input/Output control lines.

Hardware used to prevent unauthorized duplication of proprietary
software. Used in Zeus Devel oper Kits.

A unit of measure for frequency. Cycles per second.

A list of frequenciesin agiven spectrum that is used for Frequency
Hopping.

Any device or transceiver that acts as the controlling mechanism on a
network.

A PC that acts as a host in anetwork topology.
Used to detect errors in data packets.

An unobstructed straight line between two transceivers.

A term which describes the period of time two transceivers are in
sync and transmitting data. Links consist of frames.

A connector used to test Stand-alone transceivers.
A transceiver that initiates a communications link.
A unit of measure for frequency. Millions of Cycles per second.

A network topology consisting of three or more transceivers with
one transceivers connected to a Host PC.

All software used to create network topologies.
Used to describe the configurations of networks.

OEM Original Equipment Manufacturer. Typically uses Zeus Design-in
Transceivers. Also refersto alevel of accessin the Configuration
Manager.
H .
E=s  Transceiver User's Manual

G-2



Omni-directional Antenna

Peripheral
Point to Point Pair
Quick Configuration

Radio Frequency (RF)
Range
Repeater Network

Remote

RS232

Session

Slave
Spread Spectrum

Stand-alone Transceiver

Systems Integrator

TCP/IP Activator

TCP/IP Configurator
TCP/IP Intercept

Transceiver
TTL

Glossary

An antenna with range extended in a 360 degree transmission
pattern.

A devicethat is not ahost.
A network topology consisting of only 2 transceivers.

A wizard contained in the Configuration Manager application which
alows you to configure all transceivers and load the settings into
EEPROM.

A generic term for radio-based technology.
A linear measure of the distance that a transmitter can send a signal.

A network topology consisting of three or more transceivers with one
transceivers connected to aHost PC. Extends the range of a Multi-
Point Network

Any device or transceiver on a network that is not a host.

A COMM protocol and the 9 pin type of cable shipped with Stand-
aone transceivers.

A term which describes the complete process of transmission
between two transceivers. Sessions consist of links.

The target of acommunications link initiated by a master.

A radio transmission that spreads the user information over awide
bandwidth.

A Zeus Transceiver in a case with an RS232 port and external power
adaptor.

Designs or Integrates equipment systems using Zeus Stand-alone
Transceivers or OEM products built with Zeus Design-in
Transceivers.

A part of TCP/IP Intercept
A part of TCP/IP Intercept

A Network Software Utility used to connect three or more
transceivers to a TCP/IP backbone.

A two-way (transmit and receive) radio.

A 12 pin connection (interface) provided on Design-in Transceiver
boards.
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Glossary

User A level of accessin the Configuration Manager.
Virtual Ports Portsthat are created via software and used to route communications
traffic.
H
f==  Transceiver User’'s Manual

G-4



Numerics

24GHz. 3

3 Wire Cable 13
4KB buffers 5
5 Wire Cable 14
9wire cable 13

A

Access 39
Activator 70
ActiveX 26,73
ActiveX Library 73
Activity 69
Add To Report 36
Adding Virtual Ports 53, 64
Advanced View 52, 64
Alias Network Name 44
Alias Source Name 44
Antennas 18

Connector 19
Applied Settings

Store 35
Apply 35
ARQ 5
Assign Unit ID 65
Assignment arrows 51, 63
Assumptions 8
Attach/Detach to Host 54, 66
Auto Assign 65
Automatic-repeat-request 5

B

Band 3
Bandwidth 3
Baud Rate 46

Index

Bold 8
Broadcast Network 24
Buffers 5

C

Cable
3 Wire 13
5wire 14
9 wire 13
Null 14
Straight-through 14
Carrier Fees 3
Carrier Sense Multiple Access 4
Certification 16
Change Password 40
Changes
Apply and Store 34
Settings 34
Changing Information 52
Channel Access 4
Channel Latency 4
Channels 16
Clear RX Pane 87
Clear to Send 29
Clear TX Pane 87
Click 8
Communications
Seria 13
ComPort Activator 58
ComPort Configurator 50
ComPort Intercept 25, 49
Installation 18
Configuration Manager
Installation 17
Main Window 27
Configure 30
Configuring Your Unit 27
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Connection
3 Wire 13
5Wire 14
9wire 14
Connectivity 3
Connector
Antenna 19
Control Tab 70
Conventions 8
Bold 8
Click 8
Double-Click 8
Right Click 8
Select 8
Cost 2
CRC-16 5
CSMA 4
CTS 29
Current Draw 17

D

D/A | AID Loopback 45
Data Bits 46

Data Carrier Detect 28
Data Frames 4

Data Integrity 5

Data Rate 16

Data Rates 4

Data Set Ready 29
Data Terminal Ready 28
Data Threshold 47
Data Transfer 6

Data Transfer Sessions 6
DCD 28

DCE 14

Design Tab 63
Design-in
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Electrical Requirements 11
Hardware Specifications 16
Input Power
Requirements 11
Installation 9
Physical Interface
Requirements 11
Pin Out 12
Pinout 12
Destination Unit ID 44
Detach to Host 54
Dimensions 17
Direct Sequence Spread Spectrum (DSSS) 4
Directional Antennas 19
DOS Library 26
Double-Click 8
Doze 39
Draw 17
Dreport.txt 36
DSR 29
DSSS 4
DTE 14
DTR 28

E

Editing Ports 67
EEPROM 35
Electrical Interface 16

Design-in

Requirements 11

Electrical Interface Voltage Level 11
End Connection 6
Entering and Changing Information 52, 64
Error

Correction 5, 16

Detection 5

Single Bit 5




Error Detection 16
Exercises 91

Exit 29

Exit Phase 6

F

FCC Standards 2

FCC Warning 2

FEC 5

FHSS 3

Flow Control 46

Flow control 16

Forward Error Correction 5

Frequency 16

Frequency Hopping Spread Spectrum (FHSS) 3

G

Gain 18
Getting Started 8
GPIO Mode 47

H

Half Rate Coding 5

Hard disk space 17

Hardware
Specifications 16

Help 8

Hop Table 31,41
Numbers 41
Validate 41

Hopping Parameters 42

Humidity 17

Idle 6

IDs 43

Indoor Range 16

Industrial 3

Input 55, 67

Input Current Draw 17

Input Power 17
Design-in

Requirements 11
Stand-alone
Requirements 11

Installation
Configuration Manager 17
Design-in 9
Hardware 9
Intercept Utilities 18
Network Utilities 18
Software 17
Stand-alone 10

Instantaneous RSSI 86

Interface
Requirements 11
Voltage Levels 11

Interference 5

ISM 3

ITU 5

L

Latency 4
Learning Exercises 91
Library

Active X 73
License-free 3
Lights

Status 28
Link Acquisition 6
Links 4
Load Default Settings 35
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Load Driver 58, 69, 72

Load With Windows 59, 72
Local Instantaneous RSSI 45
Local Time-Averaged RSSI 45
Loopback Test 83, 85

Lower Data Rates 4

M

Manual

Changes 34

Using 7
Manufacturer's Statement 2
Max Bad Hop 42
Max No Data 42
Medical 3
Menu Bar 28
Microsoft Excel 37
Modification Tabs 28
Modifying Settings 34
Monitoring Activity 69
Multi-Point Network 22

N

Narrow Bandwidth 4

Narrow Signal 3

Network 21

Network ID 43

Network Software 18

Network Topologies
Broadcast Network 24
Multi-Point Network 22
Point to Point Pair 21
Repeater Network 22

Network Utilities 25
ActiveX 73
ActiveX Library 26

ComPort Intercept 25, 49
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DOS Library 26

Installation 18

TCP/IP Intercept 26, 61
Noisy Situations 5
Normal 39
Null cable 14

O

OEM
Access 39
Functions 40
Omni-directional Antennas 18
Operating Mode 30
Outdoor Range 16
Output 55, 67
Output Power 16
Owners 3

P

Parity 46
Password 27
Passwords 39
Pentium 17
Permanent Link 43
Permissions 39
Physical Interface 16
Design-in
Requirements 11
Stand-alone
Requirements 11
Physical Port Window 51, 63
Pin Out
Design-in 12
Stand-alone 12
Point to Point Pair 21
Port 46




Power Ctrl Lower Value 45
Power Ctrl Upper Vaue 45
Power Management 38
Power Modes 38
Power Output 16
Processor 17
Protocol 4, 16

ARQ 5

CMSA 4

Q

Quick Configure 30

R

Radio Frequency 4
RAM 17
Range 2
Indoor 16
Outdoor 16
Temperature 17
Ready To Send 29
Refresh 35
Reliable 2

Remove TCP/IP Comm Port 68

Remove Unit ID 57, 68
Remove Unit ID Number 68

Remove Virtua Communications Port 57

Renaming TCP/IP Ports 69
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